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Short Description

Descripción: Strategic Mine Planning SurpacWhittle v20...
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Introduction Pit optimisation allows us to produce a model for pit design based on a block model with real world constraints. This document introduces the theory behind the strategic mine planning process and provides detailed examples using the block modelling and Whittle interface functions in Surpac and the Foundation, Multi-Analysis, Advanced Analysis and Milawa modules of Whittle.



Requirements Prior to proceeding with this tutorial, you will need:



• • • • • •



To have Surpac v6.1 installed The data set accompanying this tutorial A basic knowledge of Surpac string files and editing tools To have completed the Introduction to Surpac manual To have completed the Block Modelling tutorial To have Whittle v4.3 installed



Objectives The objective of this tutorial is to allow you to complete an optimised mining study using an existing block model and other known inputs.



Workflow The process described in this tutorial is outlined below: • • • • • • • • • • • • •



Validate the required geological parameters in the block model Add cost and slope information to the model Generate reports to allow validation of the export process and for comparison purposes Export a mod and par file Have a quick tour of Whittle using a different data set Import the mod and par file and validate the data Reblock and extend the model Add slopes Optimise and produce pit shells Define the operational scenario Analyse pits using graphs and spider diagrams and choose a final pit Export the results Create a file to import into Whittle using a pit design
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A Theoretical Discussion



Course Overview



A Theoretical Discussion Overview



Before beginning to use any software, the theory behind mine planning and pit optimisation is discussed below.



Course Overview



Surpac and Whittle Strategic Mine Planning 2010



Darrienne Thobaven [email protected]



Phone: 1800 GEMCOM
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A Theoretical Discussion



Course Overview



Important Things First!



Exits Toilets Drinks Breaks/Lunch Questions



Getting To Know You Name



Darrienne



Role



Whittle Support



Company



Gemcom



Background Mining Engineer from WASM, grade control, prod and plan roles in Au, Ni, Cu/Au, diamond mines in Australia, Africa, PNG. Also consultancy and Surpac Software/Mine Planning Experience Surpac lots, Whittle fair bit, Datamine macros, Medsystem bit Reason You Are Here/What Do You Want to Know? I want to know what you want to know!
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A Theoretical Discussion



Course Overview



Course Goals



For given resource block model and input parameters, know how to generate optimal shells and their reports Able to complete an uncomplicated mine planning study using Surpac and Whittle Know steps involved in strategic mine planning process Know tools available in Surpac and Whittle



Attendance Requirements



Surpac Introduction understanding Surpac Block Modelling understanding Working experience of open cut mining Exposure to mine planning concepts (have hung out with the planning engineers) (No previous Whittle experience) Access to block modelling, Whittle interface modules in Surpac and foundation, multi-analysis, advanced analysis and Milawa module in Whittle
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A Theoretical Discussion



Course Overview



Course Overview



Theory of strategic mine planning/optimisation Define input parameters Create/validate optimisation block model (Surpac) Produce optimal shells (Whittle) Choose shells for further work (Whittle) Import results to enable pit design (Surpac) Create PIL file to export pit design to Whittle (Surpac)



The Company



Gemcom is largest mine planning software company in world Headquarters in Vancouver and privately owned Products include Gems, Whittle, Surpac, Minex and Insite Originally 4 companies with head offices in different locations Total of 300 employees in 20 office locations
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A Theoretical Discussion



Course Overview



Where there’s mining, you’ll find Gemcom
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A Theoretical Discussion



Course Overview



Surpac and Whittle Strategic Mine Planning 2010



The Big Picture
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A Theoretical Discussion



Strategic Planning



Strategic Planning



Overview



Strategic Planning Situation Analysis Economic Evaluation Decision-Making Behavior



What is strategic mine planning?



Strategic mine planning: A combination of science and art. It has at its core all the geological and engineering essentials associated with extracting minerals from the earth: the science It also embrace all aspects of strategic business planning: the art
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A Theoretical Discussion



Strategic Planning



Business Plan Components



Vision and Mission Values Sustainable Competitive Advantage Strategic Thrust (cost, differentiation, niche) Value Proposition Objectives (major milestones) Strategies



Page 13 of 316



A Theoretical Discussion



Situation Analysis



Situation Analysis



Situation Analysis



Size and structure of the markets Strengths, Weaknesses, Opportunities, Threats (SWOT) Forces driving change Critical success factors (CSFs) Competitor Analysis



Size and structure of the markets



Commodities Market Share Market



(Income)



(Value)



Market Analysis (Perfect Market Reference)
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A Theoretical Discussion



Situation Analysis



Economic evaluation



You can’t manage what you can’t measure



How can you measure the value of a project? – Simple Cash flow analysis – Discounted Cash flow analysis (NPV)



NPV Analysis



Advantages of net present value (NPV) analysis include: Simple to calculate Takes into account risk Allows comparison of project with different risk profiles Independent of inflation
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A Theoretical Discussion



Situation Analysis



NPV Analysis



Disadvantages of NPV Analysis include: Does not take into account a project manager’s ability to adapt to future changes as they occur.
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A Theoretical Discussion



Decision-making Behaviour



Decision-making Behaviour



Decision-making Behaviour



What are the corporate objectives?



The first and immutable objective of a public mining company is to develop the shareholder value



Corporate Objectives



1.



Lowest quartile of the cost curve?



2.



Develop world class deposits?



3.



Hedge to protect investors of price market fluctuation?



4.



Not hedge to expose investors to the market?



5.



Increase value through expansion in reserves?
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A Theoretical Discussion



Decision-making Behaviour



Decision-making behaviour



Neutral to risk Averse to risk Sating the market’s thirst (maximum reserves) Cost positioning Other…



Decision-making behaviour



Neutral to risk – Maximize NPV – Risk adjusted discount rate takes into account opportunity cost and additional risk – Add +ve NPV projects to your portfolio – When choosing mutually exclusive projects, choose the one with the highest NPV
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A Theoretical Discussion



Decision-making Behaviour



Decision-making behaviour



Averse to risk – Choose shorter mine life, smaller pits, flatter slopes – Conservatism can lead to better chance of project recovery. – Results in lower NPV



Decision-making behaviour



Sating the markets thirst for: – Earnings per share. – Cash Flow. – Dividend Yield. – Commodity and Reserve Exposure. – Market Value. – Maximisation of Reserves.
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A Theoretical Discussion



Decision-making Behaviour



Decision-making behaviour



Maximisation of reserves – Increase the metric by which the share market will assess your value. – Possibly sacrifice NPV. – Increases propensity for share price to increase, leading to increase in shareholder wealth. – Increase access to hedging and loans.



Other decision-making behaviour



Avoid short term loss. Reconcile interests of employees, community, CEO etc. Visions, and Missions.



Page 20 of 316



A Theoretical Discussion



Decision-making Behaviour



Which behaviour does your company use? How would this affect your work?



Neutral Averse Sating the market Cost positioning Other



Decision-making behaviour



Undesirable Behavior – Mining to a prescribed cut-off. – Mining to a prescribed stripping ratio.
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A Theoretical Discussion



Decision-making Behaviour



NPV Curve



Design Criteria
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A Theoretical Discussion



Decision-making Behaviour



Maximum NPV Of the mine



NPV $m



Cost of Production NPV for the $/oz Selected pit



3500
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Decrease NPV 2500



200



2000



Increase reserves



1500



150



If the corporate objectives are to produce below $225/oz. The capacity of the mine can be increased by sacrificing NPV
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A Theoretical Discussion



Theory of Pit Optimisation



Theory of Pit Optimisation



Surpac and Whittle Strategic Mine Planning 2010



Theory of Pit Optimisation



Principles of Pit Optimisation
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A Theoretical Discussion



Mine Planning



Overview 



Mine Planning







What is Pit Optimisation?







Optimisation Algorithms







Slopes







Block Value Calculation







Commodity Price







Whittle Concepts







Block Model Dimensions







Structure Arcs and Slopes







Costs







Generation of Pit Shells







Ore Selection Method



Mine Planning



Mine Planning What does mine planning mean to you?
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A Theoretical Discussion



Mine Planning



What is mine planning? • Working out where, when, how and how much to mine • Iterative process • Affected by corporate objectives, decisionmaking behaviour of company • Can reduce risk i.e. planning for change creates robust pits that give you greater ability to deal with fluctuating markets



Mine planning can ...



Identify the feasible domain Identify the most profitable plan under different constraints Rapidly evaluate many different alternatives Help evaluate a wide range of consequences



..be a key contributor to the strategic decision making process
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A Theoretical Discussion



Resource and Reserves



What are some examples of mine planning studies?



Types of mine planning



Reserve definition Scoping study Prefeasibility study Feasibility study BFS One off question Resource definition
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A Theoretical Discussion



Resource and Reserves



Resource and Reserves



Resources and Reserves – The Traditional View Ore Body Model



Resources



Ultimate Pit Design



Cut-off Schedule



Reserves



Long-term Schedule



Short-term Schedule



JORC Code(2004) Resource & Reserve
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A Theoretical Discussion



Resource and Reserves



JORC Code(2004) - Mineral Resource



Resources require economic evaluation!



JORC Code(2004) - Ore Reserve



Reserves must be economically viable
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A Theoretical Discussion



Inputs



Ore Reserve Development Stages



Data collection and geologic interpretation Geological block model construction Mining dilution incorporation Pit optimisation Pit scheduling Final design Final schedule Tabulation of reserve estimates



Inputs



Mining Factors



Human Nature



Interest Rates



Economic Uncertainty



Power Costs Capital Costs



Dynamic and constantly changing



Inflation



Commodity Prices



Labour Costs Contractor Costs



Mother Nature Geological Uncertainty



Jointing & Bedding Lithology



Constantly changing as more information is collected



Faults Mineralization Limits & Types



Complex
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A Theoretical Discussion



Inputs



Geological uncertainty



Mineralisation limits Mineralisation grades Faults Jointing and bedding Lithology Hydrology



Constantly changing as more information is collected



Topography



Economic uncertainty



Interest rates Inflation



Dynamic and constantly changing



Power costs Capital costs Commodity prices Contractor costs Labour costs
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A Theoretical Discussion



Inputs



Technical parameters



Slope angles Tonnage & grade model Dilution Mining recovery Milling recovery Rock properties, continuity, & bulk density Mining methods Production Rates



Economic parameters



Discount rate Mining costs Processing & overhead costs Commodity price
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A Theoretical Discussion



Pit Optimisation



Quick Review



True or false: Resources do NOT involve economic evaluation What do all parameters have in common? Name 3 types of mine planning study.



Pit Optimisation



What is Pit Optimisation?



Answers some of the questions - how big and where to mine? Maximises cash flow Provides nested shells - mine schedule – Where to start – How to schedule to maximize NPV
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A Theoretical Discussion



Pit Optimisation



Definition of Optimal Outline



AIR WASTE



MINERAL



With fixed prices, costs and slopes: the optimal outline is fixed



What is Optimum?



NPV



Potential value improvement



Extra value foregone



Strategy 1



Strategy 2



Selected Pit size



Pit size
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A Theoretical Discussion



Pit Optimisation



Project Sensitivity



$3,000



Pit Value



$2,500 B $2,000 A



$1,500 $1,000 $500 $0 0



2,000



4,000



6,000



8,000



10,000 12,000



Pit Tonnes



What Affects the Optimal Outline? In general: –



If the price increases, the pit gets bigger



–



If the costs increase, the pit gets smaller



–



If the slopes increase, the pit gets deeper
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A Theoretical Discussion



Pit Optimisation



What Affects the Optimal Outline?



Price Costs Slopes



Small Pit



Pit Size



Larger Pit



Fix these and you Fix the Optimal Outline!



Quick Review



Draw typical NPV vs pit size graph Where does the highest NPV pit sit? Where does the least sensitive pit sit? Name 3 factors that affect the optimal pit? Which factor is most likely to affect the pit the most?
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A Theoretical Discussion



Optimisation Algorithms



Optimisation Algorithms



Optimisation Algorithms



Floating Cone and Lerchs-Grossman



Floating Cone Method Position an inverted cone, with the required slopes, on each block with a positive value If the total value of all blocks in the cone is positive, “mine” those blocks Repeat these steps until no cone has a positive value There are two problems – could mine too little or too much.
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A Theoretical Discussion



Optimisation Algorithms



Three Dimensional L-G



Works with block values Works with block mining precedences Guarantees to find the three-dimensional outline with the highest possible value



Quick Review



What are the two main types of optimisation algorithms? Which one does Whittle use? Which one is guaranteed to give the highest possible value?
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A Theoretical Discussion



Slopes



Slopes



Slopes



What is an ARC? C An arc is a relationship between two blocks. An arc from block A to block B indicates that, if A is to be mined, then B must be mined to expose A. The reverse is not true. If B is to be mined, block A may or may not be mined.



Used to control pit slopes
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B If A is mined so is C A



A Theoretical Discussion



Slopes



Arc Relationships



B Arc from A to B



If A is to be mined, B must be mined to expose A The reverse is not true If B is to be mined, A may or may not be mined



A



Benches



Slope accuracy depends on No. benches used for arc generation



Desired Slope
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A Theoretical Discussion



Slopes



Slope Accuracy



Slope accuracy is controlled by number of benches used in arc generation for a given block size Exact slope accuracy is very unlikely because only whole blocks are mined



Summary



Whittle uses arcs to represent slopes Exact slope accuracy is unlikely Accuracy is controlled by the number of benches used in arc generation
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A Theoretical Discussion



Block Value Calculation



Block Value Calculation



Block Value Calculation



Block Value Calculations



Profit = Revenue - Costs Value = [ (Ore*Grade*Recovery* (Price-CostS)) - (Ore*CostP) ] - Rock*CostM) Ore = ore tonnes CostP = cost of processing CostM = cost of mining Rock = total tonnes
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A Theoretical Discussion



Block Value Calculation



In other words…



Block Value = Revenue - Costs Revenues can be calculated from: – – – –



Ore tonnages Grades Recoveries Product price



Costs can be calculated from: – – –



Mining cost Milling cost Overheads



What is Value?



Which Truck is Worth the Most? 1. 2. 3.



50 tonnes of 2g/t Gold 100 tonnes of 1 g/t Gold 150 tonnes of 0.5% Copper & 0.25 g/t Gold
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A Theoretical Discussion



Block Value Calculation



50 tonnes of 2g/t Gold



= [(2 * 50 * 92.5% * $12.30/g ) - (50 * $15)] - (50 * $1.20)



Revenue



Costs



[(1137.75) - (750)] - (60)



$327.75



100 tonnes of 1 g/t Gold



[(1*100 * 92.5%* $12.30/g) - (100 * $15)]- (100 * $1.20)



Revenue



Costs



[(1137.75) - (1500)]- (120)



-$242.25
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A Theoretical Discussion



Block Value Calculation



But wait!



If we just call this truck load waste We only pay $120 to mine it. We would be $122.25 better off



150 Tonnes of 0.5% Copper & 0.25 g/t Gold Revenue from gold



= [(0.25*150



Revenue from Copper



* 50%* 12.30 + 0.5%*150 *75%*2094 ) - (150 * 8)]- (150 * 1.20)



Costs [(230.625)+ (1177.875) - (1200) ]- (180) 1408.50- 1380



$28.50
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A Theoretical Discussion



Block Value Calculation



When does the truck go to the waste dump?



Whenever the cost of processing is higher than the revenue, we should treat the truck load as waste



Value = The Section in square Brackets must => 0



[ (Ore*Grade*Recovery* Price) - (Ore*CostP) ] - Rock*CostM



In other words…



The block will be mined regardless of the destination and CostM will be incurred either way. The decision of whether the truck is ore or waste (i.e. the cut off grade) is made at the top of the pit. The cut off grade is independent of mining cost – a marginal cut off grade.
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A Theoretical Discussion



Commodity Price



Marginal Cut-off



Marginal Grade =



CostP Recovery* Price



This marginal cut-off condition will change whenever Processing costs, Recoveries or Prices change!



Summary



Block Value = Revenue - Costs •Cut off grade is dependent on CostP, metallurgical recovery and price. •Cut off grade is independent of CostM
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A Theoretical Discussion



Commodity Price



Commodity Price



Commodity Price



What commodity price do we realize? Profit = [ (Ore*Grade*Recovery* (Price-CostS)) - (Ore*CostP) ] - (Rock*CostM)



Price - Selling Cost Refining Royalty Insurance Market
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A Theoretical Discussion



Commodity Price



Commodity Price



Predictions are often not right "Wall Street indices predicted nine out of the last five recessions ! " - Paul A. Samuelson in Newsweek, Science and Stocks, 19 Sep. 1966.



Commodity Price Price most powerful influence on profit. Future prices influenced by: – Historic/Statistical (trend, cyclical, random). – Forces driving change (in market analysis context). Strategic responses: – Forecast future prices. – Plan to accommodate future uncertainty. – Decision points, mine life considerations. – Price control (hedging, become a price-setter).
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A Theoretical Discussion



Whittle Concepts



Whittle Concepts



Whittle Block Model (mod file)



Block line



I J 19 36



Parcel line



I J 20 36



K No parcels MCAF



PCAF



tonnes



1



1.000



2160.



1



1.000



K ROCK



tonnes



1 SULF



2160.
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metal2 305.



A Theoretical Discussion



Whittle Concepts



Whittle Framework Origin



Gemcom



Medsystem



Datamine Vulcan Whittle (Block 1,1,1)



Whittle vs Surpac Whittle works in IJK which is No blocks in x,y,z Surpac works in N,E,RL which is co-ords in y,x,z Whittle does not store grade – only contained metal Surpac has user blocks and (smaller) sub-blocks Whittle has blocks and parcels MCAF and PCAF and slope attached to blocks, ROCK and grades attached to parcels
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A Theoretical Discussion



Whittle Concepts



What’s a “Parcel”? Part of a block for which rocktype, tonnage, and metal content are known The total tonnage of the parcels may be the same or less than the block tonnage If the parcel tonnage is less than the block tonnage, the remaining tonnage is undefined waste (unknown rocktype) If a block has no parcels, the total tonnage of the block is undefined waste Neither the position of a parcel within a block, nor it’s shape is defined UNLIKE sub-blocks in Surpac



Parcels C1



Ore A



Tonnes A Metal A



Ore B



Tonnes B Metal B



Ore C1



Tonnes C1 Metal C1



Ore C2



Tonnes C2 Metal C2



Ore C3



A C2 B



Tonnes C3 Metal C3



C3



+



Undefined Waste



Profit = (Ore*Grade*Recovery* (Price-CostS)) - (Ore*CostP) ] - Rock*CostM) Metal A



Tonnes A



Tonnes A



Metal B



Tonnes B



Tonnes B



Metal C1



Tonnes C1



Tonnes C1



Metal C2



Tonnes C2



Tonnes C2



Metal C3



Tonnes C3



Tonnes C3 +



Undefined Waste
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A Theoretical Discussion



Whittle Concepts



Parcels In the previous diagram, each parcel is evaluated separately to determine destination Each parcel within a block can go to a DIFFERENT destination i.e. ore and waste in the same block Parcel size is important for selective mining issues



Summary Whittle works in I,J,K not N,E,RL Whittle stores contained metal, not grades Whittle has blocks and parcels similar to Surpac blocks and sub-blocks Except location and shape of parcel is unknown And sum of parcel tonnage may be less than block tonnage (the rest is undefined waste) Each parcel can go to a different destination
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A Theoretical Discussion



Block Model Dimensions



Block Model Dimensions



Block Model Dimensions



Different Block Dimension for Different Purposes



Geology - outlining the orebody



Mining - calculating values Sensitivity analysis - pit value vs. price
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A Theoretical Discussion



Block Model Dimensions



Dimensions of a Block - Geology



•



Often depends on method of interpolation



•



1/dn interpolation often results in small block size



•



Kriged model often results in larger block size



Dimensions of a Block - Mining



Minimum block size is SMU size (smallest mining unit) – reblock geological blocks to SMU size (consider parcel size)



Equipment size – minimum working space – multiple SMU’s in equipment size block – use template in Minimum Mining Width
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A Theoretical Discussion



Block Model Dimensions



Dimensions of a Block - Sensitivity Analysis



Geological model often contains millions of blocks Coarser approximation of grade distribution (100,000 blocks) sufficient for sensitivity analysis



Framework Expansion – Easy to add blocks in Whittle Original Model Extended topography SubSub-region boundaries



X offset



Additional waste blocks



Z offset Expanded Model
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A Theoretical Discussion



Block Model Dimensions



Adjusting Framework



Blocks that are added contained all of the information of the last block in the mod file EXCEPT metal content which is zero. Possible to increase and decrease block size and framework
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A Theoretical Discussion



Slopes and Structure Arcs



Slopes and Structure Arcs



Slopes and Structure Arcs



Slopes



Rectangular regions (Whittle) Rock codes (Mod file – Character attribute in Surpac) Zone Numbers (Mod file – Integer attribute in Surpac) Profile Number File (Text file containing I, J, K, Number)
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A Theoretical Discussion



Slopes and Structure Arcs



One method – bearing and slope



Bearing



Slope Angle



20



42



77



38



135



46



180



42



260



38



335



44



If using bearing, be careful….



60



60 55



45



45



55



Constant



Constant



Slope



Slope



60 55



45 60



• Slope is defined at four azimuth points • Between points the slope is interpolated



• Slope is defined at six azimuth points • Between differing points the slope is interpolated • Between similar points the slope is constant
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A Theoretical Discussion



Slopes and Structure Arcs



Slope Bearings



It is very important to note that bearings are given instead of wall positions. Any walls at right angles to the bearings, in a particular slope region, will have the given slope applied.



In the diagram, the slope specified for a bearing of 45 degrees would be used by the program in the positions indicated by the arrows.



Slope Considerations Rule of thumb bench search for arc generation in each sub-region – (max(x,y) x 8) / z



Whittle uses overall slopes which need to include allowance for the ramp
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A Theoretical Discussion



Slopes and Structure Arcs



Summary Four possible slope methods Remember Whittle uses bearings not wall positions. Remember slopes are smoothed between bearings Use overall slopes and make allowance for ramps Whittle employs rule of thumb to calculate number benches for arc generation
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A Theoretical Discussion



Mining Recovery and Dilution



Mining Recovery and Dilution



Mining Dilution and Mining Recovery



Mining Dilution Whittle defines dilution as extra waste taken to the mill Ore tonnes are increased while metal is the same so grade decreases. For a dilution of 5% on 100t @ 2 g/t, the resulting ore is



100x1.05 t for 200g (grade = 200/105 g/t) =105t @1.90g/t
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A Theoretical Discussion



Mining Recovery and Dilution



Mining Recovery Whittle defines mining recovery as ore taken to the waste dump Ore tonnes and metal are decreased so that grade is the same For a recovery of 5% on 100t @ 2 g/t, the resulting ore is



100x0.95 t for 0.95x200g =95t @2g/t



Mining Recovery and Dilution Dilution



ORE



Mining Recovery (extraction loss)



MINING LIMIT Profit = [ (Ore*Grade*Recovery* (Price-CostS)) - (Ore*CostP) ] - Rock*CostM)



x Mining Recovery



x Mining Recovery x Dilution
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A Theoretical Discussion



Costs



Costs



Costs



Calculating Costs



Types of Costs



Units



Mining cost



$/tonne mined



Processing cost



$/tonne processed



Selling costs



$/unit of product



Some time costs must also be included
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Block Value - Rule 1



The value must be calculated on the assumption that the block has already been uncovered – Make no allowance for stripping



Block Value - Rule 2



The value must be calculated on the assumption that the block will be mined – If block contains some ore that can be profitably processed it should be included in the value of the block - even if total value of block is negative.
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Block Value - Rule 3



Any expenditure that would stop if mining stopped must be included in the cost of mining, processing or selling. – The converse is also true



Block Value – Rule 4



No bias. Loading any cost estimate just to be conservative must be avoided Use sensitivity runs to determine the impact of cost variations. If you use bias you will end up with a smaller pit and a lower NPV.
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The Block Value Formula VALUE = (METAL x RECOVERY x PRICE – ORE x COSTP) – ROCK x COSTM METAL = units of product eg ore tonnes x grade RECOVERY = Proportion of metal recovered from processing PRICE = the price per unit of product sold ORE = tonnes of ore in a parcel COSTP = the extra cost of mining a parcel as ore and processing it ROCK = total amount of rock (ore and waste) in a block COSTM = the cost of mining a tonne of waste



Why Time Costs Must be Included When Whittle adds a block to the pit outline, it effectively extends the life of the mine. Any extra costs which result from extending the life of the mine must be paid for.
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Sharing Time Related Costs How costs are shared will depend on whether production is limited by: – Mining – Processing, or – Marketing



Reference Block Reference Block : •Used to calculate CAFs •Represents the base case scenario for mining •Typically positioned at the top of the pit •Does not have to physically exist
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Reference Block and Positional Cost Adjustment Factors Positional Cost Adjustment Factor: •Increased mining cost with depth •Variable mining cost for ore and waste (equipment) •Variable processing costs •Applied either in Whittle or Surpac



Profit = [ (Ore*Grade*Recovery* (Price-CostS)) - (Ore*CostP) ] - Rock*CostM) x PCAF



x MCAF



Summary Cost must be in units of relevant activity Any cost that continues when the production stops should NOT be included in the optimisation Do NOT add a stripping allowance or be conservative with the parameters CAFs are calculated from a reference block The reference block does not have to exist but should give CAFs .



Page 69 of 316



A Theoretical Discussion



Pit Shells



Pit Shells



Generation Of Pit Shells



Revenue Factors A simple way of scaling values to provide a range of pit shells which are optimal for different prices If the base price (RF=1) of gold is $800/oz RF = 0.5 has a gold price of $400/0z RF = 2.0 has a gold price of $1600/oz
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Parametric Pit Shells Inner pit shells show where it is best to begin mining Intermediate pit shells show possible practical cutbacks Pits near RF of 1 are used for sensitivity and risk analysis Higher RF pit shells show possible future expansions



Plan



Deriving Nested Pit Shells • A range of revenue factors yields nested shells • A revenue factor of 1 corresponds to the commodity price in the parameter file Revenue = [ (Ore*Grade*Recovery* (Price-CostS)) - (Ore*CostP) ] (Rock*CostM) x Revenue Factor
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Summary Nested pits are generated by the revenue factors Revenue factor is used to scale the commodity price Inner pits used for cutback Outer pits used for infrastructure placement
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Ore Selection Methods



Ore Selection Methods



Ore Selection Methods



Two main methods are cut-off or cashflow In simple situations they will give the same result. If expressions using cut off grade variables are included then MUST use cashflow
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Ore Selection Methods



Ore selection by Cut-off: –



–



Selection is done by comparing the grades of the material with precalculated processing cut-offs. If it does not satisfy the cut-offs, it is treated as waste.



Ore selection by cash flow: –



–



Selection is done by comparing the cash flow which would be produced by processing it and the cash flow which would be produced by mining it as waste. If the cash flow from processing it is higher, the material is treated as ore. If not, it is treated as waste.



Ore Selection by Cut Off – Single Element CUT–OFF = PROCESSING COST/RECOVERY * PRICE Often used since the cut-off grade is printed in the report. BEWARE – the reported cut-off grade is only valid for blocks with PCAF=1 The cut-off grade is different for every block with a different PCAF.
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Ore Selection by Cash Flow



Profit = [ (Ore*Grade*Recovery* (Price(Price-CostS) CostS) - (Ore*CostP (Ore*CostP)) ] - Rock*CostM Rock*CostM))



If in doubt, use cashflow.



Summary
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Input Mining



Finance • Commodity Price(s) Price(s)



•Costs



• Discount Rate



•Ore Selection •Dilution & Recovery



• Corporate Objectives Economic Model



Geotech •Slope Stability



Metallurgy •Recovery



Geology



•Costs



•Tonnes



•Processing Rates



•Grade



•CutCut-off Grades



•Rocktypes
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Course Workflow



Surpac and Whittle Strategic Mine Planning 2010



Course Workflow
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Process Overview In Surpac



In Whittle



Validate geological parameters



Import model and validate Reblock & extend framework Add slopes Optimise



Add cost & slope info Generate reports for validation



Define operational scenario Analyse pits using graphs, schedules & spider diagrams



Export block model



Select pits Export res or msq or pit shells



In Surpac Import res or msq or dxf Design pits Export PIL file



In Whittle Import PIL (pit design) Scheduling & analyses



A Simple Mining Study Start with geological block model including grade/s, sg, rock codes (mdl in Surpac) Ensure rock code is correct for optimisation purpose Ensure all blocks have grades, sg and rock code (reports and visual constraints) Ensure no negative grades or sg (reports, assign value) Ensure AIR definition is correct (topo dtm) Ensure AIR blocks have sg=0, grades=0 (reports, assign value)
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A Simple Mining Study



Define & allocate costs Add mcaf attribute and fill (add attribute, assign value) Add pcaf and fill (add attribute, assign value) Finalise slopes Add zone attribute and fill (add attribute, assign value) Create bm reports for validation (bm report) Export block model (mod and par file created)



A Simple Mining Study Create new project Import model into Whittle (Block Model Node) – Check Model Validity Reblock model & extend (ReBlock Node - mod) Pit slopes (Slope Sets Node - stu) – Check slope errors Define costs and generate shells (Pit Shell Node -res) – Mining – Processing – Selling – Prices
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A Simple Mining Study Add limits and $ (Operational Scenario node) Add spider graph (Spider Graph Node) – What is project sensitive to? Add pit by pit graph (Pit by Pit Graph Node) – Which is optimum pit? Add a schedule graph (Schedule Graph Node) – Refine choice of ultimate pit – Choose cutbacks Export pit shells ( res file from Pit Shells Node or msq file from schedule graph ) Import res or msq file into Surpac (create mdl file)



A Simple Mining Study



Prepare data for design (slice bm) Design pit Assign cutback numbers to block model (assign value) Create PIL file Import PIL file into Whittle Continue schedules and reports
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Advanced Analysis Schedule – Best Case (inner shell out) – Worst Case (top down) – Specified (using pushbacks) Detailed Cash flow – DCF (Discounted Cash Flow Analysis) – NPV (Net Present Value = Σ Discounted Cash flows) – Adjustment for Time Costs – Variables changing with Time – IRR (Internal Rate of Return) Sensitivity – Spider Diagram – Advanced sensitivities – (Custom Graphs & Advanced Analysis)



Advanced Optimizations



Cut-off Optimization – Stockpiles



Milawa – Best NPV mode – Balanced mode



Blend Optimization – Bulk Mineral – Extractive Process
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Other Tools Reblocking Tools – Parcels – Combining & Splitting Blocks – Calculating MCAFs & PCAFS (Cost Adjustment Factors for each block) Minimum Mining Width Block Value Calculation – For Checking Variables – Expression – Changing by time
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Exercise 1 – Mod and par file creation in Surpac Overview



Using typical data (including geological block model and other inputs), create a validated Surpac block model with mcaf, pcaf and zone number. Export the Surpac block model to produce a mod and par file ready for use in Whittle.



Requirements



The data files required for this exercise are: bg_id2_070313.mdl, topo2007.dtm, topo2007.str



Getting started



Please note: This manual uses version 6.1 of Surpac.



As this type of work is very repetitive and can generate large numbers of files, it is vital to have a structured file naming convention. For this course the data structure will be multiple directories according to data function beneath a root of c:\training\data as shown below:



1. Within Explorer, create a separate directory for the training data and beneath this directory create a new directory called 1_originaldata and several others as shown above. Copy the data files into the 1_originaldata directory. VERY IMPORANT – Do NOT put spaces in the directory names.
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2. Before starting Surpac, go to the desktop and right click on the Surpac icon. Change the Start in directory to the one that has just been created.



3. Change the menus so that only the Main Menu and Block Model Menu are displayed by placing the mouse pointer over a space on a menu or toolbar and right clicking. Also display the Block Model Toolbar in the same way.



Note: When discussing any block model functions in this tutorial, they will be referred to from either the block model menu or block model toolbar.



4. Open the block model file bg_id2_070313.mdl by selecting this file from the navigator with the left mouse button and then dragging it into the graphics viewport. The block model status item will appear at the bottom of the Surpac window as shown below:
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5. Choose Block model > Summary. This will display a form summarising the properties of the block model and will appear as follows:



One of the important features of the block model to note is the number of user blocks in each direction – 160 in Northing, 100 in Easting and 75 in RL giving a total number of user blocks of 1.2 million. Whittle has a limitation of 999 blocks in any direction so this block model does not need to be modified for this limitation.



In addition, it can be seen from the list of attributes that three attributes exist defining gold grade and a further three attributes could define the rock type – litho, rock and weathering. An attribute called sg exists which is one piece of required data and some attributes have a background value of -99.



6. Click Apply on the form to close it.
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All attributes are summarised below:



Attributes Name



Type



Decimal s



Background



Au_cut20



Real



2



-99



Au_cut15



Real



2



-99



au_uncut



Real



2



-99



ave_dis



Real



3



-99



count



Integer



0



Litho



Character



Sed



min_dist_samp Mined



Real



3



-99



Character



N



Num_samp



Integer



-99



Pass



Integer



0



Rescat



Character



UNCLASS



rock



Character



sg



Real



Weathering



Character



2



1.8 fresh



Only one attribute per grade item is exported to Whittle so it is necessary to ask the person supplying the geological data which gold grade is relevant. For this exercise, the au_cut15 attribute is the appropriate attribute.



7. To preserve the original data (which is possibly the resource block model and should not be modified), save the block model to a new name in the 2_optimisation_bm directory.
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8. In the navigator, highlight the 2_optimisation_bm directory, right click and choose Set as work directory.



9. Choose Block model > Save File As, then delete the path name and type in a new model name to indicate this is being created for the purposes of optimisation – bg_opt_070322.



The three required attributes needed for optimisation which could be sourced from the geological block model are 1. grade attribute (only one in this case, au_cut15, but more are possible) 2. density 3. rock code
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A geotechnical attribute defining slope types could also be generated from the geological block model. An attribute called sg defines density. Let’s investigate the model for a possible rock code and also a geotechnical code. The rock code chosen depends on what is required for later reporting purposes and also how the mining costs, processing costs and metallurgical recoveries are defined.



Mining Cost ($/BCM) Waste RL from RL to RL centre L&H D&B Dewater Presplit Rock Bolt Rehab Total 400 380 390 1.31 0.30 0.00 0.00 0.00 0.08 1.69 380 360 370 1.82 0.15 0.04 0.00 0.00 0.08 2.08 360 340 350 2.32 0.52 0.04 0.00 0.00 0.08 2.95 340 320 330 2.72 0.96 0.06 0.00 0.00 0.08 3.82 320 300 310 3.29 1.56 0.06 0.05 0.06 0.08 5.09 300 280 290 3.64 2.10 0.06 0.05 0.06 0.08 5.98 280 260 270 4.29 2.40 0.06 0.05 0.06 0.08 6.93 260 240 250 4.44 2.88 0.06 0.05 0.06 0.08 7.56 240 220 230 4.69 3.22 0.06 0.05 0.06 0.08 8.15



Processing Cost ($/t ore) Porphyry Only Admin Haulage Personnel Consumab Process L&H add GC Hcap 1.88 3.00 0.63 0.19 9.00 0.05 Oxide 1.88 3.00 0.63 0.19 9.00 0.20 Tran 1.88 3.00 0.63 0.19 10.25 0.27 Fresh 1.88 3.00 0.63 0.19 10.50 0.30 Ultramafics and Sediments Admin Haulage Personnel Consumab Process L&H add GC Hcap 1.88 3.00 0.63 0.19 9.00 0.05 Oxide 1.88 3.00 0.63 0.19 9.00 0.20 Tran 1.88 3.00 0.63 0.19 10.25 0.27 Fresh 1.88 3.00 0.63 0.19 10.50 0.30



2.05 0.50 0.45 0.41



Total 16.79 15.39 16.66 16.90



0.00 0.00 0.00 0.00



Total 14.74 14.89 16.21 16.49



Cost



Value



Unit



Comment



Administration



1.5 million



$ pa



Head office



Personnel



0.5 million



$ pa



Manager, eng, geo, surv, etc



Consumables



150,000



$ pa



Computers, vehicles, aerial



Ore Haulage



3.00



$/t hauled



Contractor costing



Overall Slopes in Degrees Lithology



400 RL – 320 RL



< 320 RL



Ultramafics



38 (1)



42 (4)



Sediments



40 (2)



48 (5)



Porphyry



44 (3)



55 (6)
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Metallurgical Recovery Weathering



Recovery



Hardcap



94%



Oxide



94%



Transition



94%



Fresh



90%



In this exercise, mining and processing costs have been defined by RL, weathering and lithology and will be assigned by an attribute. The metallurgical recoveries are listed by weathering type and schedules are required by weathering as well. The geotechnical zones are defined by RL and lithological code. Let’s investigate the block model for relevant data.



10. Choose Display > Display block model to display the entire block model.



The following form appears:



11. Fill in the form as displayed above and click Apply to draw the model with block faces.
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Support desk tip



When I try to display my large block model (say 300 Mb), Surpac stops with Smartheap Library – Out of Memory messages. What can I do?



There are 2 things you could do to deal with large block models running out of memory. Firstly go to Customise->Default Preferences. On the left hand pane, choose System Options and on the right panel the last option is Java Virtual Machine. Change that to 512. Secondly, the option in the form above to use Point Cloud instead of Blocks uses much less memory and will sometimes be the difference between being able to display the model or not.



The model should be centred in the graphics viewport as the Rescale option has been checked and should look similar to the image below:



To get a better indication of where the ore deposit is located in the block model, a graphical constraint can be added to display only the blocks where the gold value is greater than zero.
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12. Choose Constraints > New graphical constraint. 13. Enter the information as shown and then click Apply.



The block model is displayed as shown:
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Note that for all functions that have the option of either selecting from a menu or using a button from a toolbar, the first instance in this document will reference the menu option but the subsequent instances will reference the toolbar button. For example, the graphical constraint function could have been accessed from the toolbar button as shown below:



14. Rotate the constrained block model around to gain familiarity with the deposit. 15. Run a block model report to investigate the values in the weathering attribute. 16. Choose Block model > Report. 17. Enter the information on each form as shown and Apply each form.
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In the form below a few of the options are explained for clarity. Format Headers? This option allows the user to flag whether they wish to reformat the header fields in the table. When ticked, all underscores will be replaced with a space and each word will begin with a capital letter. This formatting generally produces neater looking results. When un-ticked, the headers will retain their original formatting. This is useful for maintaining the integrity of data when importing and exporting between applications. Use Volume Adjustment? A volume adjustment should be made if the physical volume of a block is different to that implied by the blocks' dimensions in the model. For example, an expansion factor for excavated material, or if differential dilution and reduction has been applied. Select `Yes' if you wish to use pre-determined volume adjustments for blocks. Geometric Grouping? This allows reporting by groups of solids, strings or DTMs.
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By selecting to report all values for the character attribute of weathering, any blocks with a value of null will also be reported.



Note:



The Keep blocks partially in the constraint check box changes the way the block is selected for inclusion in the constraint. The default method in Surpac uses the centroids to define whether the block is inside or outside the constraint. Ticking this block will report the entire block if ANY part is inside the constraint (rather than the centroid being inside) Please be careful using this, because if you use it in things like the mineral inventory report, and do not use it in conjunction with a volume adjustment factor, you will be over-estimating your resource.
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Leaving the constraints form blank as above will report on all blocks contained in the block model.



The report should look like that displayed below. The weathering attribute contains the values of hardcap, oxide, transition or fresh. Note that there are no blocks with a null weathering value, some blocks do contain the default au_cut15 value of -99 and that no air blocks are present.



18. Create similar reports for the attributes of litho, rescat and rock.



Do any of these attributes contain null values? How many tonnes have been classified? Which attribute appears to be the basis for the sg values?
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From the above investigation, we have decided to use weathering as the basis for the rock code required by Whittle, litho for the geotechnical definition and to keep the following attributes for further processing: Au_cut15 Sg Litho Weathering
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For comparison purposes, we’ll note the size of the block model file. 19. In the navigator, right click on the block model and select Properties. The file size is displayed in the message window – 65,953,976 bytes. Remembering there are 1024 bytes in a kB, the file size in Mb is 62.8 Mb.



20. Check that Block Model Audit is on by looking at the button on the right hand side of the Block Model Toolbar. If it is not recording, turn it on by toggling the button.



A block model audit can be dumped as a macro which is very useful for both an audit trail and use in the next optimisation study. You will look at this function further later in the course.



To speed up processing time and reduce hard disk space, delete the attributes which are not required. Note:



If attribute 2 is a calculated attribute referencing attribute 1 then attribute 2 must be deleted before attribute 1.



21. Choose Attributes > Delete. 22. Enter the information on the form as shown below and Apply the form.



One way to navigate to the next line in the form above is by using the Tab key.
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23. Save the block model and again display the file size in the message window using the navigator. The new block model is 19.2 Mb in size which is less than half the size of the original and the expected result as we have deleted more than half of the attributes. Support desk tip



Why bother deleting unnecessary attributes?



There is a good reason to delete attributes in the block model that are not essential for the Whittle export. These nonessential attributes could be causing sub-blocking to occur in the model. A major factor affecting the process time in Whittle is the number of parcels in a Whittle model. The sub blocks in a Surpac model are converted into parcels in a Whittle model file. The nonessential attributes could be causing sub-blocks which mean additional parcels in the mod file. Deleting these attributes ensures that the minimum number of parcels is created in the mod file:



24. Before making any changes to values in the model, generate a block model report by weathering for all blocks with Au_cut15>0.5g/t. (Using the previously created byweather.bmr). This will allow a comparison between the geological model and the optimisation model.



Mineral inventory au_cut15>0.5g/t Weathering



ktonnes



Au g/t



Au koz



Hardcap



101.5



1.42



5



Oxide



887.5



1.76



50



Tran



1,917.5



1.65



102



Fresh



1,949.0



1.81



113



Total



4,855



1.73



270
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Rock Code Whittle requires a code defining rock type with character values which must be no longer than 4 characters in length. For this rock code, Whittle has a limit of 250 values total i.e. 250 different rock codes. Although not necessary, you will ensure that every block in the model has a value for the rock code and that characters are uppercase for ease of report reading.



The weathering attribute will be the basis of the rock code but it needs to have the air blocks defined as well. We will modify the weathering attribute to include air blocks and then add a calculated attribute called rock which will satisfy the requirements of Whittle. Air blocks are defined by the topo2007 dtm. (It is vitally important to check that this dtm covers the entire surface area of the block model.) We will assume that the rest of the values for the weathering attribute are defined correctly.



1. Choose Estimation > Assign Value. 2. Enter the information on the forms as shown and Apply each form.



It is vitally important that a validation is performed after every modification is made to the block model. Validations can be performed using 1. 2. 3. 4.



a graphical constraint a block model report colouring of the block model block ID of individual blocks



Page 99 of 316



Exercise 1 – Mod and par file creation in Surpac



Rock Code



Visually check the weathering values by adding a graphical constraint for each value.



3. Add a graphical constraint to display the air blocks as shown below:



Do the air blocks cover the entire area of the block model? Was the top of the model set too low? Repeat for the other weathering types. How thick are each of the types?



Check that there are no null values in the weathering attribute. Null values can be found in two ways:



• •



generate a block model report that is unconstrained and the tonnage of null values will be reported add a graphical constraint with a space for the value e.g. rock= (the form will not accept a blank value for rock but if you insert one space this is read as a null value)



Add the new rock code as a calculated attribute. 4. Choose Attributes > New. 5. Enter the information on the form as shown and Apply the form.



The complete formula is shown below.



iif(weathering="air","AIR",iif(weathering="hardcap","HCAP",iif(weathering="oxide","OXID", iif(weathering="transition","TRAN","FRSH"))))
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Character values are case sensitive so “AIR” and “air” are different values. Be very careful with capitals and spelling. Note also that Surpac automatically converts the attribute name to lowercase regardless of the case entered in the form.



Support desk tip



Problem hunting syntax errors



An easy way to find syntax errors in an expression is to copy the expression to Word or some text editor and do the following •



Count the number of open and close brackets



•



Ensure character values (like OXID) have “” around them.



•



Ensure an if statement starts with iif not iff



•



Ensure an if statement has a , after the test, value1 and value2 parts i.e. iif(test,value1,value2)



•



Ensure values such as rock codes are spelt correctly



6. Check the mdl file size after the addition of this calculated attribute. 7. Validate the new attribute and check that all blocks have a value for the rock attribute by creating a new block model report.



Don’t use ROCK as a rock code



Whittle will not allow the value of “ROCK” or “rock” to be used as a rock code. Ensure the rock code attribute does not contain the word rock in either upper or lower case.
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Support desk tip



Layers of AIR



Multiple layers of AIR blocks cause problems in Whittle and should be avoided unless they actually exist. An example of this issue is when the block model has been extended beneath an existing model and the additional blocks have been given a rock code of AIR. Although Surpac’s functionality does not lend itself to this situation, data imported from other packages may have this issue.



We have created the AIR blocks in this case but when this is not the case, ensure that a visual check is performed on all AIR blocks. An easy way is to add a graphical constraint and make sure that AIR blocks only occur above the intended topo.



What’s the difference between the “block maths” and the “assign value” functions?



The main difference between the two functions relates to saving the block model. The Assign Value function is found under the Estimation menu and any function under that menu prompts for a Block Model Save after the function is complete. Functions under the Attribute menu (including Block Maths) do not prompt for a Block Model Save.



For the Assign Value function, it is not necessary to perform a Block Model Save. Use of either function is personal preference. If Block Maths is used, and something went wrong with the model immediately after the function (and before any manual save) then the changes will be lost from the model. If the Block Maths function is used then it is imperative to regularly save the model manually using Block Model Save. This manual uses the Assign Value function to avoid manual saving of the model.
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Gold Grade The Whittle export function requires at least one grade attribute. Several conditions are not valid and should be tested for and rectified: • •



negative grades non-zero grades in blocks defined as air



For this exercise the gold grade attribute is au_cut15.



1. Clear any graphical constraints and display any blocks with negative grades. 2. Choose Constraints > Remove all graphical constraints. 3. Choose Constraints > New graphical constraint. 4. Enter the information on the form as shown below and Apply the form.



The block model is displayed as shown below:



The majority of the blocks in the model have the background value of -99. Page 103 of 316
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Remove this constraint and display the air blocks with grades above 0.



5. Choose Constraints > New graphical constraint. 6. Enter the information on the form as shown and Apply the form.



Note that each line typed into a constraint form can be used in a variety of combinations. Options for the combinations include AND, OR and brackets. AND is equivalent to the intersection so that in the example above, for a block to be included in the constraint, it must fulfill BOTH lines a and b. OR is the equivalent of a union. For a block to be included it must fulfill one or both of lines a and b. The block model is displayed as shown below:



Blocks exist for both conditions that need to be modified. 7. Choose Constraints > Remove all graphical constraints.
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8. Choose Estimation > Assign value. 9. Enter the information on the forms as shown below and Apply each form.



Verify that the above actions have given the expected result by viewing the attributes for a random block. 10. Choose Attributes > View attributes for one block and select one of the blocks at the top of the model.
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The form below appears.



11. When you are finished with the form, click Apply. 12. Visually verify that no blocks exist with negative gold grades by using the graphical constraint function. 13. Using the Assign value function, set all grades to 0 for air blocks and then check that the change was successful. 14. Check the size of the mdl file.
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Density The Whittle export function requires an attribute to define density. The situation of air blocks with a nonzero density is illogical and must be rectified.



1. Visually display air blocks with a non-zero density. The block model will appear as shown below:



2. Set the density of the air blocks to 0 and visually check that the changes were successful. 3. Check for other illegal values such as a negative sg or a zero sg in blocks that are NOT air. 4. Using the navigator, display the size of the block model and note that it is 32.6 Mb. 5. Generate a new block model report using the rock.bmr format file for all blocks with au_cut15>0.5.
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Density



The report is shown below:



The above report can be compared with the same report for the id2 block model to quantify the changes in tonnes, grade and contained metal.



Mineral inventory au_cut15>0.5g/t Rock Hardcap



ktonnes



Au_uncut g/t



Variance with bg_id2_070313 Au koz



ktonnes



Au_uncut g/t



Au koz



98.3



1.45



5



-3.1%



2.1%



-1.1%



887.5



1.76



50



0.0%



0.0%



0.0%



Tran



1,917.5



1.65



102



0.0%



0.0%



0.0%



Fresh



1,949.0



1.81



113



0.0%



0.0%



0.0%



Total



4,852



1.73



270



-0.1%



0.0%



0.0%



Oxide
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Density



Note that the changes have only occurred in the top most rock code where the air definition has influenced sg and grade.



6. It is also advisable to check that there are no blocks with sg=0 beneath the topo unless that situation is intended and that no negative values for sg exist.
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Assessment



Theory Assessments Draw a NPV/Tonnes curve Which pit has the highest NPV? Which pit is the least sensitive to change? What controls slope accuracy in Whittle? How does Whittle store the location of the block? What is the difference between parcels and subblocks?



Exercise 1 Assessments



What are the 4 way to validate a change in the block model? Why is it important to delete unnecessary attributes? What 3 types of data could be sourced from the geological block model? What needs to be checked about the topo dtm?
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Slopes in Whittle



Surpac and Whittle Strategic Mine Planning 2010



Slopes in Whittle



There’s More Than One Way….



Within Whittle there are several ways to present slopes The slope information can be included in the mod file or input into the Java GUI (Whittle)
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Slopes



Rectangular regions (Whittle) Rock codes (Mod file – Character attribute in Surpac) Zone Numbers (Mod file – Integer attribute in Surpac) Profile Number File (Text file containing I, J, K, Number)



Slopes
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Slopes



Benches



Slope accuracy depends on No. benches used for arc generation



Desired Slope
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Adding Slopes to the Surpac Block Model A geotechnical study has recommended slopes by depth and lithology. An allowance has been made for a 20 metre wide ramp and the following overall slopes are the basis for the zone attribute value (shown in brackets):



Overall Slopes in Degrees Lithology



400 RL – 320 RL



< 320 RL



Ultramafics



38 (1)



42 (4)



Sediments



40 (2)



48 (5)



Porphyry



44 (3)



55 (6)



The attribute could be added as an integer and then filled using assign value or it could be added as a calculated attribute. We will try both methods to illustrate the difference in file size and time required.



First we’ll add the attribute as an integer.



1. Choose Attribute > New, and enter a name of Zone, type of integer and background value of 1. 2. Using the Assign value function, fill the attribute with the values shown in the table above. 3. When finished, display the properties of the block model file.



The integer attribute adds 4 Mb to the block model file size.



4. Delete the zone attribute using Attributes, Delete. 5. Display the block model file size and check it has returned to the previous size. 6. Choose Attributes > New. 7. Enter the information shown below and Apply the form.
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The full formula to calculate the zone attribute is shown below:



iif(litho="Ultramafics",iif(_zcen>320,1,4),iif(litho="Seds",iif(_zcen>320,2,5),iif(_zcen>320,3,6)))



Notice that the syntax for attribute formulae does allow spaces (everywhere except within character values like “Ultramafics” and also allows the iif command to be in upper case (e.g. IIF)



8. Again, use the navigator to display the file size. The calculated attribute does not increase the block model file size and has the advantages of being faster to add, quicker to process and the formula can be edited without having to delete the attribute and add it again.
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Costs in Whittle



Surpac and Whittle Strategic Mine Planning 2010



Cost Handling



There’s More Than One Way….



Within Whittle there are several ways to present costs for mining and processing They can be included in the mod file or input into the Java GUI (Whittle)
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Costs in Whittle



Mining Costs Single value (Reference cost in Whittle) Value or expression for rock codes (CAF in Whittle) Single expression (Whittle) MCAF (Mod file – attribute in Surpac)



Processing Costs



Value or expression for rock codes (Reference cost in Whittle) An expression (Whittle) PCAF (Mod file – attribute in Surpac)
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Costs in Whittle



Processing Costs



Block Value Rule 3



Any expenditure that would stop if mining stopped must be included in the cost of mining, processing or selling. – The converse is also true – Every block added to the outline extends the life of the mine. The extra cost incurred by extending the mine life must be paid for
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Costs in Whittle



Block Value Rule 4



No bias. Loading any cost estimate just to be conservative must be avoided Use sensitivity runs to determine the impact of cost variations. If you use bias you will end up with a smaller pit and a lower NPV.



The Block Value Formula



VALUE = (METAL x RECOVERY x PRICE – ORE x COSTP) – ROCK x COSTM



METAL = units of product eg ore tonnes x grade RECOVERY = Proportion of metal recovered from processing PRICE = the price per unit of product sold ORE = tonnes of ore in a parcel COSTP = the extra cost of mining a parcel as ore and processing it ROCK = total amount of rock (ore and waste) in a block COSTM = the cost of mining a tonne of waste
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Reference Block Reference Block : •Used to calculate CAFs •Represents the base case scenario for mining •Typically positioned at the top of the pit •Does not have to physically exist



Calculating Costs



Types of Costs



Units



Mining cost



$/tonne mined



Processing cost



$/tonne processed



Selling costs



$/unit of product



Some time costs must also be included
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What to Include? Costs to Include – Incremental (or variable) Costs • Directly proportional to tonnage or unit of product • Wages, fuel, explosives etc • Costs must be included in the associated activity (e.g. drilling in mining)



Costs that May or May NOT be Included – Expenses that are related to time NOT production (fixed) • INCLUDE expenses that would stop if mining stopped • EXCLUDE expenses that would not stop if mining stopped



Include



Time costs which would stop if mining stopped: • Site administration • Site infrastructure maintenance • Interest on working capital loan • Capital replacement • Truck purchase (long project)
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Mining Costs Examples ($/t MINED) Drill & Blast Load & Haul



Dayworks Mobilisation/Demobilisation Site Clearing & Topsoil



Mine Services – – – –



Geological Grade control In-pit supervision Surveying



Support (Geotechnical)



Dewatering



Process Costs Examples ($/t PROCESSED) Ore handling (additional costs) Grade control Stockpile management Crushing & Grinding Reagants Mill Services Maintenance
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Ore Handling Example: – – – –



Waste mining = $0.82/t Ore Mining = $1.54/t Treatment = $7.37/t COSTP = $8.09 (1.54 - 0.82 + 7.37)
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Costs in Whittle



Selling Costs ($/unit of Product) Refining & Smelting Bullion/Metal Transport Insurance Marketing Shipping (to customer)



Time Costs ($/year) Interest on working capital loan



Camp costs Administration



Capital replacement



Communication



Truck purchase (long project)



Legal Services Safety & Training Any Other Fixed Costs
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Why Time Costs Must be Included When Whittle adds a block to the pit outline, it effectively extends the life of the mine. Any extra costs which result from extending the life of the mine must be paid for.



Sharing Time Related Costs How costs are shared will depend on whether production is limited by: – Mining – Processing, or – Marketing
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Production Limited by Mining



Example: –



Heap leach operation



Every block that is mined extends the life of the mine. Time costs should be added each block that is mined Therefore add to mining costs.



Production Limited by Processing



The most common scenario –



Gold CIP/CIL



Only mining of ore blocks extends the life of the mine. Ore block values should include an allowance for time costs. This should be added to the processing cost
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Production Limited by Sales Output limited by market capacity



Psst! Wanna buy some diamonds?



– Most industrial minerals – Coal, iron ore



Time costs are added to the selling cost Cost expressed as $/unit of product



How Time Costs are Calculated In each case, the amount added is the annual cost divided by the throughput limit per year.



OR
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Size Really Does Matter! Mmm !



To express costs as a pertonne or per unit basis, you must first make assumptions about the production rate. If the size of the pit produced by your optimization makes these assumptions inappropriate, the costs must be recalculated and the optimization done again.



DIRECT COSTS (easy)



Mining



Processing



Comments



Blasting Load & Haul Miner's Wages



Reagents Stockpile management Mill Wages



Are easily determined
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cost per unit of production.



Stop ?



YES
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CAPITAL COSTS (easy)



Mining



Processing



Comments



Stop ?



Exploration Costs



Cost of Mill



Must be depreciated over the life of a project (or pit)



NO







FIXED COSTS



Mining



Processing



Mine Admin Mine Admin Can be applied on either side



Comments These stop when mining stops but should they be mining or processing costs?
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On-Site Services (Complex)



Mining



Processing



Grade Control Grade Control







Rehabilitation



?







Maintenance



?



Comments



Stop ?



Not always obvious where the cost should be applied. often the cost actually has two or more components



?



Bank Loan Charges



Mining



Processing



Working capital Up front fee on loan to build for pre-strip mill







(complex)



Comments



Stop ?



Repayments, fees and interest
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Compensation



Mining



Processing



Land Holders Royalties







Comments



Stop ?



Including fees and royalties



?



Road ? Maintenance



Example Time Cost Calculation



Time Costs per year



$980,000



Expected annual mill throughput



1,000,000t



Time costs per tonne milled



$0.98/t



Expected annual mine fleet capacity



4,000,000t



Time costs per tonne mined



$0.24/t
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Example Time Cost Calculation cont.



Incremental Costs ($/t) Bench



Mining Waste



Mining Ore



Extra for mining Ore



Milling Ore



1



$1.05



$1.87



$0.82



$8.25



2



$1.17



$2.15



$0.98



$8.25



3



$1.29



$2.47



$1.18



$8.25



4



$1.41



$2.84



$1.43



$8.25



5



$1.53



$3.26



$1.73



$8.25



Example Time Cost Calculation With throughput limit on MILLING ($/t)



Bench



Mining Waste



Milling Ore



Extra for Mining Ore



Time Cost



Milling Cost COSTP



5



$1.05



$8.25



$0.82



$0.98



$10.05



4



$1.17



$8.25



$0.98



$0.98



$10.21



3



$1.29



$8.25



$1.18



$0.98



$10.41



2



$1.41



$8.25



$1.43



$0.98



$10.66



1



$1.53



$8.25



$1.73



$0.98



$10.96
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Example Time Cost Calculation With throughput limit on MINING ($/t) Mining Waste



Time Cost



Mining COSTM



Milling Ore



Extra for Mining Ore



Milling Cost COSTP



5



$1.05



$ 0.24



$1.29



$8.25



$0.82



$9.07



4



$1.17



$ 0.24



$1.41



$8.25



$0.98



$9.23



3



$1.29



$ 0.24



$1.53



$8.25



$1.18



$9.43



2



$1.41



$ 0.24



$1.65



$8.25



$1.43



$9.68



1



$1.53



$ 0.24



$1.77



$8.25



$1.73



$9.98



Bench



Example 1 – Cost of Processing Mill



Assume Mill cost $10 million to build If the mine were to be shut down shortly after opening, the mill will have: – A salvage value – Unrecoverable amount (sunk cost)
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Unrecoverable Amount ($4 million)



An “upfront”or “sunk” cost Enter as an Initial Capital Expenditure in Operational Scenario OR Subtract from optimized value of pit



Salvage Value ($6 million)



Extent of Salvage Value will depend on: Ongoing maintenance and capital replacement – Theoretically the $6 mill is recoverable and is therefore not a cost – However maintenance & capital replacement would stop if mine stopped so include as Time Cost



Alternately only essential maintenance carried out & mill value gradually declines over life of mine The expected rate of reduction should be treated as a time cost
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Example 2 - Trucks



If the expected life of the mine is shorter than the life of the trucks – treat same as mill If life of mine is long – progressive truck purchases would stop if mining stopped. Cost of replacement must be averaged over the life of the mine and treated as a time cost



Example 3 – Administration Costs



On-site admin usually stops if mining stops. If it will stop – include as a time cost. Head office admin may or may not stop if mining stops – therefore such costs may or may not be included.
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Example 4 – Loan for Initial Costs



Repayment of a loan to cover upfront (sunk costs) must continue if mining stops. Costs should not be included in Block Value. – However unless the mine is able to service the cost from cash flow, the project should not proceed. – Can be added as an upfront capital cost in operational scenario



Example 5 – Loan for Recoverable Costs



Cash borrowed for working capital or capital replacement would be repaid if mining stopped. – Therefore interest paid on such a loan would stop if mining stopped. – Include interest cost as a time cost. – Use real interest rate not notional rate
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Example 6 - Grade Control



Often necessary to do grade control on waste as well as ore. – Technically correct to identify such waste and add cost of grade control. – Experience has shown that this can be a waste of time. – Quicker approach is to estimate cost of grade control of ore and waste and load to ore blocks.



Example 7 – Cable Bolts Cable bolts permit wall steepening – Reduces size of pit and saves waste stripping – Transform cost to $/t waste
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Cost Adjustment Factors



Whittle assumes all costs are calculated for a particular block called the Reference Block The Reference Block can be anywhere Mining & Process costs are worked out for the Reference Block even if there is no appropriate material in that block



Cost Adjustment Factors



Whittle deals with variation in these costs with positional cost adjustment factors – Mining CAF = Mining Cost/Reference Mining – Process CAF= Process Cost/Reference Process



Usually Mining increases with depth A second “rock-type” adjustment factor can be applied to waste mining in the mining cost table.
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Cost Adjustment Factors



Positional Cost Adjustment Factors can be added using Range Expression in Whittle Best to use Surpac to calculate CAFs for individual blocks MCAF = Mining Cost / Ref COSTM PCAF = Process Cost / Ref COSTP
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Adding Costs to the Surpac Block Model Within Whittle, costs are divided into three types: 1. Costs applying to every block mined known as mining costs with units of $/t mined 2. The extra cost of mining and processing ore applying only to blocks processed known as processing costs with units of $/t processed 3. Costs associated with the end product (the bar of gold in this case) known as selling costs with units of $/element unit($/g)



The project is situated in the Goldfields of Western Australia with a head office in Perth. Currently the mill is fed by an existing pit that is finishing soon and most of the costs have been collected or forecast using the existing pit actual costs. The project is the only source of ore at the time it will be mined. The mill capacity is 800,000 tpa. As mining is being undertaken by contractors, there is more flexibility with the mining capacity. For this exercise we’ll use a nominal mining capacity of 3,000,000 BCM pa.



Costs for this project are listed below:



Cost



Value



Unit



Comment



Administration



1.5 million



$ pa



Head office



Personnel



0.5 million



$ pa



Manager, eng, geo, surv, etc



Consumables



150,000



$ pa



Computers, vehicles, aerial survey



Ore Haulage



3.00



$/t hauled



Contractor costing



A mining contractor has provided the pricing shown below:



Mining Cost ($/BCM) Waste RL from RL to RL centre L&H D&B Dewater Presplit Rock Bolt Rehab Total 400 380 390 1.31 0.30 0.00 0.00 0.00 0.08 1.69 380 360 370 1.82 0.15 0.04 0.00 0.00 0.08 2.08 360 340 350 2.32 0.52 0.04 0.00 0.00 0.08 2.95 340 320 330 2.72 0.96 0.06 0.00 0.00 0.08 3.82 320 300 310 3.29 1.56 0.06 0.05 0.06 0.08 5.09 300 280 290 3.64 2.10 0.06 0.05 0.06 0.08 5.98 280 260 270 4.29 2.40 0.06 0.05 0.06 0.08 6.93 260 240 250 4.44 2.88 0.06 0.05 0.06 0.08 7.56 240 220 230 4.69 3.22 0.06 0.05 0.06 0.08 8.15



The metallurgical recoveries and costs have been provided on the basis of weathering while grade control will be conducted in the hardcap and oxide as sampling of ditchwitch lines in porphyry material only. The grade control for transition and fresh material will be blast hole sampling of porphyry material only.
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Possible processing costs are shown in the table following: Processing Cost ($/t ore) Porphyry Only Admin Haulage Personnel Consumab Process L&H add GC Hcap 1.88 3.00 0.63 0.19 9.00 0.05 Oxide 1.88 3.00 0.63 0.19 9.00 0.20 Tran 1.88 3.00 0.63 0.19 10.25 0.27 Fresh 1.88 3.00 0.63 0.19 10.50 0.30 Ultramafics and Sediments Admin Haulage Personnel Consumab Process L&H add GC Hcap 1.88 3.00 0.63 0.19 9.00 0.05 Oxide 1.88 3.00 0.63 0.19 9.00 0.20 Tran 1.88 3.00 0.63 0.19 10.25 0.27 Fresh 1.88 3.00 0.63 0.19 10.50 0.30



2.05 0.50 0.45 0.41



Total 16.79 15.39 16.66 16.90



0.00 0.00 0.00 0.00



Total 14.74 14.89 16.21 16.49



Note that the load and haul component listed above is only the extra cost of mining ore, over and above the cost of mining waste. For example, in the hardcap waste costs $1.31/BCM to mine while ore costs 1.31 + (0.05*sg) = $1.40/BCM to mine.



For this exercise the mining costs and processing costs will be contained in the mod file and need to be added as attributes in the Surpac block model.
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MCAFs Rather than adding the mcaf as a real attribute and using the assign value function based on RL, the mcaf can be defined as a formula (line of best fit) and added as a calculated attribute. The table of mining costs on page 6 gives the total unit mining cost in $/BCM. A reference mining cost must be chosen so that the MCAFs can be calculated. Choosing the highest defined cost of $1.69/BCM as the reference cost and dividing by the density of 1.8 for hardcap the reference cost (or COSTM) is $0.94/t.



We will add the mining cost per BCM to the model as the formula based on RL and use calculated attributes for mining cost per tonne and mcaf. A spreadsheet can be used to graph the mining cost ($/BCM) versus RL and a line of best fit found as shown below:



Mining cost $/bcm vs RL



y = -0.0437x + 18.453 R2 = 0.991



9.00 8.00 7.00



$/bcm



6.00 5.00 4.00 3.00 2.00 1.00 0.00 200



250



300



350



400



RL



Be careful when generating the formula from a graph using Excel that a graph type of XY Scatter graph is used rather than a Line graph. Also always check the formula before using by manually calculating the cost for a given RL.



1. Add the following calculated attributes:



mincost_pbcm



-0.0437*_zcen + 18.453



mincost_pt



iif(sg=0,1,mincost_pbcm/sg)



mcaf



mincost_pt/0.94
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Note that it is important to test for impossible conditions and deal with them in any expression. When a block has sg = 0, then mincost_pt has a divide by zero error if no test is included. In this case, a warning message appears in the message window and the attribute is given a value of -1. There is no fatal error and it is possible to export a model with these negative values.



Be careful when adding attributes to ensure the type is calculated and not real. If real is chosen the formula will be seen as a description and all of the blocks will have a value of 0. An easy way to tell that the attribute is calculated while still in the form is that the background value will be greyed out if calculated is chosen but will be white if real is chosen.



Note for using calculated attributes: The beauty of using calculated attributes is that the formula can be changed without having to delete the above 3 formulae. However if the mincost_pbcm is modified, only the updated values for mincost_pbcm are immediately shown. To see the correct values for the mincost_pt and mcaf attributes the block model must be closed and opened again.



2. Visually check some blocks for expected values of the new attributes.
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PCAFs For this exercise, processing cost is dependent on both lithology and weathering. If the processing cost is only dependent on weathering we could enter it within Whittle since we’ve chosen weathering as the basis for the rock code.



Within Whittle, each rock code has its own reference processing cost rather than one for all codes as in mining cost.



We will choose the hardcap processing cost as the reference cost (or COSTP) for the two groups of costs – porphyry and others (ultramafics and sediments).
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Porphyry Total Pcaf 16.79 1.0000 Hcap Oxide 15.39 0.9166 Tran 16.66 0.9923 Fresh 16.90 1.0066 Ultramafics and Sediments Total Pcaf Hcap 14.74 0.8779 Oxide 14.89 0.8868 Tran 16.21 0.9655 Fresh 16.49 0.9821



COSTP for all rock codes is $16.79. Again we’ll add the pcafs shown in the table as a calculated attribute. The relevant formula is: iif(rock="AIR",1,iif(litho="Porphyry",iif(rock="HCAP",1,iif(rock="OXID",0.9166,iif(rock="TRAN",0.9923,1.00 66))),iif(rock="HCAP",0.8779,iif(rock="OXID",0.8868,iif(rock="TRAN",0.9655,0.9821)))))



3. Save the block model.



4. Again validate the pcaf attribute by either blockID or block model report.



All of the block model functions performed on the model so far, have been stored in the block model audit trail. 5. To display the audit trail, choose Block Model > Display Model Audit Trail.



A form similar to that below will appear.
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The comments shown next to each function can be changed or deleted. The audit trail can also be saved as a macro and used in the future. 6. Click Save as Macro, type in the macro name of bmaudit and Apply the form. 7. Right click on bmaudit.tcl and select Edit.



Note:



Be careful not to double click on the tcl file in the Surpac navigator as this will run the macro!!



Parts of this macro could be used on another project with only small modifications.



Support desk tip



A valid Whittle model file does not contain any 0 or negative mcafs or pcafs. In this case we have generated the mcafs and pcafs so that they cannot be 0 or negative. When defined in a different manner, always perform a check for the invalid case of 0 or negative values:
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Exporting the Mod and Par files The block model contains the appropriate attributes and they have been validated. The final step is to export the mod and par files. Apart from the names of the attributes for rock, sg, mcaf, pcaf, zone and grade, the export function has several other options.



The mod file can be exported as fixed or free format. Fixed format is easier to read but free format produces a smaller file and is easier to edit so we will use free format. Remember that Whittle works in X,Y,Z while Surpac is Y,X,Z.



The export function has several options for the export block size. The form will default to the minimum block size but it is possible to export at any block size that is a multiple of 2 of the user block size. Each sub block will be exported as a separate parcel in the mod file. Whittle has a limit of 999 parcels per block and 999 blocks in any direction. Due to the limitations it is recommended to export at the user block size or the minimum block size to ensure the limit is not reached. Reblocking can be done in Whittle.



Mcaf and pcaf can be defined two ways for the export –



• •



Attributes (as we have done) Values (simply type in a value to be used for the caf in every block in the model, typically a value of 1 is used as the default)



The Surpac export function requires an attribute or value for mcaf and pcaf however it is possible to leave the input box blank. If no attribute or value is entered, Surpac will automatically use the first real attribute in the attribute list sorted alphabetically, in the place of the particular caf attribute. For this reason, ALWAYS have an attribute or value for mcaf and pcaf even if it only contains the value of 1 for all blocks.



The rock code for air is required and also the rock code for waste. If it is known that some blocks definitely have no grade and there is no need to differentiate between the rock codes for waste then a single waste rock code can be entered. Usually the different types of waste will be required for scheduling or cost purposes and it is best to allow the optimisation process in Whittle determine what is waste and what is ore. In this case, it is acceptable to enter a code for waste that does not exist in the block model. The form requires that a value be entered.



The export function also has an option to validate the Surpac block model for Whittle requirements. Many of the checks that have been performed manually are checked BEFORE a mod and par file are created. After the validation is complete, a report is written and if any blocks contain values that are illegal, the value of WTLERROR is written to an attribute created for error identification purposes. The validation does not have to be performed before export however it is recommended to validate each time an export is performed.



The form contains additional fields for Block value (a mod file format not covered in this course), mine number (if multiple projects are to be seen as one project in Whittle) and an entire section on Pit List file export.
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Exporting the Mod and Par files



The volume adjustment attribute is used to modify the ore tonnes in a block but NOT the total block tonnes. This attribute is a factor less than one i.e. 0.8 not 80%. If the block has 100t @ 2 g/t, without the volume adjustment the ore parcel contains 100t @ 2 g/t for 200g. If the volume adjustment was 0.5 then the total block tonnes remain 100t while the parcel contains 50t @ 2 g/t for 100g.



1. Choose Block Model > Export



2. Enter the information shown below and Apply the form.
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Exporting the Mod and Par files



In the above form the required attributes are detailed in the table below. Description



Attribute Type



Rock code



Character or calculated



Mcaf



Real, float or calculated



Pcaf



Real, float or calculated



Zone



Integer or calculated



Sg



Real, float or calculated



Mine number



Integer or calculated



Block value



Real, float or calculated



Grades



Real, float or calculated



The error report is automatically opened with your default text editor. If the validation failed no mod and par file will be created. An example of a validation report from a block model that passed the tests is shown below.
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Exporting the Mod and Par files



The export report is also opened in the default text editor. This will be used for validating the import into Whittle later on.



After the validation and export reports are displayed a mod file of 75.8 Mb size and a par file are created.
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Exporting the Mod and Par files



Open the mod and par files in a text editor shown below. Compare the mod file to the file format shown on page 50.



What data do you think the columns in the par file below represent?
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Exporting the Mod and Par files



Support desk tip



Parcel Limit Exceeded



If an export block size is chosen such that more than 999 parcels would result, Surpac displays a warning similar to that shown below:



SSI Warning: Block 13, 19, 10 has more than 999 ore parcels. The parcel list has been truncated and some data lost. Change the block size to rectify this



The mod file is still written but only the first 999 parcels of a block are included and the remaining parcels are simply lost. The total tonnage of the project would not be correct and the model should be exported again with less than 999 parcels per block.



Negative Element Grade



If the validation option is chosen in the Export function, Surpac will check whether the grade attribute contains negative values. If a negative grade value exists, the report will display the problem as shown below:



The block model will have an extra attribute added called “error” in our case and the blocks with negative grades will have the value of WTLERROR written to that block. The remaining blocks will have a NULL value. To display the problem blocks, use a graphical constraint such as that shown below of error != (space)
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Exporting the Mod and Par files



If the block model validation for any of the other reasons listed, the same results as above will occur.



Wrong AIR code



The rock code is case sensitive so if “air” was entered instead of “AIR”, as shown below, the mod file is written with an extra rock code containing parcels with the tonnage calculated using the density attribute. For this reason, it is important to ensure AIR blocks have sg=0 in case an error is made at the export stage.
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Exporting the Mod and Par files



Constraining block model export



It is possible to NOT include all of the blocks in the block model export by constraining the export. Unlike a traditional Surpac block model, Whittle does not require that the block model contain blocks everywhere in the model space. Be careful when using a constraint for the Whittle export. Whittle will only allow blocks of the same type to NOT be included in the mod file i.e. all air or all waste. For example it is fine it export all blocks except the air blocks as these blocks will all have a density and therefore costs and revenue of zero. It is also fine to include air in the export but not include the waste well outside the mineralisation which has the same density and mining cost. It is not correct to exclude air blocks and some waste blocks in the Whittle mod file since these have different densities and costs.
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Assessment



Assessment



Exercise 1 Assessments What checks need to be performed on the grade attribute/s? What function would you use to change the sg of Air blocks to zero? How can you problem hunt a syntax error in an expression? What are the 4 ways to define slopes in Whittle?



Exercise 1 Assessments How are the CAFs calculated? What should always be generated before exporting the mod and par file? What information is contained in the par file? What are the 2 types of information that could be used for mcaf or pcaf in the Surpac export?
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A Quick Tour of Whittle



Exercise 2 – Creating and selecting optimal shells in Whittle Overview



Using the mod and par file generated in the previous exercise, produce optimal pit shells, create a quick schedule and select pit shells for design work.



Requirements



The data files required for this exercise are: the mod and par file created in the previous exercise.



Getting started



Before continuing work on the bg dataset, we will briefly explore the Whittle work environment using the Marvin dataset which is provided with Whittle software. The aim of this section is simply to become familiar with parts of the software rather than understand the reasoning behind the values used.



A Quick Tour of Whittle Open Whittle using either the icon on the desktop or the start menu. The Whittle Flash Screen is displayed followed by the main Whittle window and a small message that the program is checking settings. The first dialogue you must supply appears next. This requires you to select the project on which you wish to work.



In this walk through we are going to use the Marvin1 project.



1. Make sure Marvin1 is highlighted (clicking on any project with the mouse highlights that project). 2. Then click on the OK Button.
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A Quick Tour of Whittle



After a short wait and a ‘loading, please wait’ courtesy message, the main work area screen will be displayed as shown below: Conventional windows drop-down menu bar



Tool Bar



Data Pane



Navigation Pane Page 156 of 316
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A Quick Tour of Whittle



This is the main Whittle window. It has several sub-sections. At the top of the window you will see the familiar looking title, menu and tool bars. Below, on the left, is the Navigation pane. You build up an analysis model consisting of various data, functions and results in the Navigation pane.



On the right hand side is the Data pane, which displays a set of tabbed dialogue areas containing data, settings and results. At the very bottom is a status bar, on the right hand side will be your license details.



The Navigation Pane



I Description



Status Line Display toggle



The items that you can see in the Navigation pane are called "Nodes". Each node represents a set of inputs, processes and results. The nature of the data, process and results depends on the type of node. Lines link each node to its parent (above and to the left) and its child or children (below and to the right). Parents provide data and results upon which the node depends. Children depend on the data and results in a node.



Icon: Illustrates the sort of data and results the node contains. Description: User-defined text. Status line: Shows the status of the data and Results. Display toggle: Click on it to show or hide child nodes. STRATEGIC MINE PLANNING SOFTWARE Page 157 of 316
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A Quick Tour of Whittle



Working in the Navigation pane



Click on a node (left mouse button). The data and results associated with that node will be displayed in the Data pane. Right click on a node (right mouse button). A menu will appear which shows all the operations that you can perform on that node (including export). Click on a display toggle. All nodes in the tree with children have a display toggle. Click on the toggle to display or hide the child nodes.



The Data Pane



The blue highlight indicates this line is selected



Tabs



When you change data you must press accept to store the changes.



Working in the Data pane



Some basic activities are described here:



Finding data and results: Data and results are kept in tab-folders. Click on a tab to see the data or results that are stored there.
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A Quick Tour of Whittle



Changing data: Text and numbers in simple fields can be edited directly (click or double click on the field). Data in tables can be edited by selecting the data and clicking on the edit button next to the table.



Help: Most buttons have hover help. Hold the mouse pointer over a button and a descriptive message will appear. All tab-folders have a Help button. Click on the button for context-sensitive help or use F1.



The dialogue area has a range of open text boxes, choice lists, buttons and tick boxes to suit the type of data being entered. In general, if the field is white you can change it and enter data directly. Some buttons work on a line of a section of data at once and you must first select the appropriate line.



The Menus & Tool Bars



The menus in Whittle are very similar to any other Windows program. They have standard pull down lists. Some items have extra submenus, indicated by the small right facing triangle. They give you access to all file, navigation and node tasks. The tool bar provides duplicate access to many of these tasks and all node tasks can also be achieved by clicking or right-clicking on a node when it is highlighted.



The Tool Bar is probably the easiest way to learn how to set up and control the Whittle programs. The SAVE (floppy disc symbol) OPEN (opening file symbol) ADD (plus sign) and the three RUN-ning men will help you perform most tasks.
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A Quick Tour of Whittle



At certain nodes you will be able to view the optimal shells, model and schedule. This is indicated by the little inverted cone icon on the right-hand side of the tool bar becoming coloured (when you have nothing to view it is greyed out).



Once you become proficient with Whittle you will probably find that working in the data and navigation panes is easy and you will most likely make use of the right-mouse click to activate a context sensitive menu. This menu displays all items that can be used at that node.



3. Go to the Project node and click on the description tab. In the data pane, make some notes at the end of the description and Accept the changes. 4. Go to the block model node and click on the dimensions tab. Look at the block model dimensions. 5. Click on the Help button and note the context driven help. Look at the differences between the pit shells node and the operational scenario node. 6. Click on the Messages tab and note that no messages are shown as the node has not been run yet. 7. Right click on the block model node, select Add and note that only Slope Set, Reblock Block Model and Grade Tonnage Graph are available.
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A Quick Tour of Whittle



8. Click on the Basic Slope Set node and select the Description pane. Change the node description and Accept. 9. Try to copy and paste a branch. We will run all of the nodes. 10. Go to the project node and select the Run All Nodes button.



As the nodes are running, a running man appears in the bottom left corner next to the progress bar and the interrupt man appears on the toolbar.



When each node is successfully completed, a green tick appears next to the icon and the output, report and messages panes will display results/messages. 11. Go to the pit shells node, select the Mining tab, change the reference mining cost and Accept the changes. 12. Highlight the pit shells node and select the Run From button.
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A Quick Tour of Whittle



Whittle software has similar security to Surpac. The software files can be installed on any PC but require a hardlock (sentinel or dongle) and a license file. The Whittle license file is called the ini file and usually has a name similar to fx_3870_090202.ini where 3870 is the license number and 090202 is the date. The Whittle license file is slightly different to the Surpac token file arrangement.



A new ini file is NOT required for a new version of the software. The ini file has two date fields – MaintenanceExpiry and LicenseExpiry. If the computer’s system date is after LicenseExpiry, then no version of Whittle software will work. If Version Release Date < Maintenance Expiry Date then that version can be used. Although the software will continue to work after the expiry date, the ini file will not work with a version of Whittle that was created AFTER the license expiry date. For licensing queries contact the support desk – [email protected].



The default installation of Whittle installs the program files and training data in the c:\whittle\fx43 directory (for version 4.3). The default location for the ini file is in the whittle\fx41 directory.
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A Quick Tour of Whittle



Beneath this directory are the directories shown below:



In the programs directory the group of exe files which make up the Whittle software executables are stored. These executables could be run from a DOS prompt.
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A Quick Tour of Whittle



The projects directory contains the Marvin and other training datasets. It is recommended to place any project data in a separate area. When a new project is created called say gold, Whittle creates a directory called gold at the location specified by the user. Two project files called gold with the extensions fxp and fxb are also created along with a sub-directory called working_gold. The working directory contains all of the files generated by Whittle as work is completed.



When a node is run, it creates a series of files called FXPE_1.(ext) for the first node run, FXPE_2.(ext) for the second node run, etc. The files with a pr? extension are print files for the node e.g. an optimisation print file is called pro and a reblock print file is called prr. The print file is the file displayed in the report pane of each node.



It is not recommended to edit files within the working directory as Whittle generates and handles them automatically. Place any files relevant to the Whittle project in the directory above e.g. gold not gold_working.
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A Quick Tour of Whittle



We’ll look at the place in Whittle to specify the location of the ini file. 13. From the File menu, select Preferences



The Preferences form opens to the file locations tab. The name and location of the ini file is specified as well as the default location to create new projects.
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A Quick Tour of Whittle



Support desk tip



Licensing error messages



If the dongle number and the ini file number do not match the following error message is displayed.
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A Quick Tour of Whittle



Choose OK and Whittle will allow a project to be opened and will display green ticks next to each node. If a node is run the following error message will be shown in the message window and a red exclamation mark will appear as the status icon.



To resolve the problem choose File->Preferences as per above.
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A Quick Tour of Whittle



Where is the license number shown in the bottom right of the GUI read from? The license number shown at the bottom of the GUI is read from the ini file and does not reflect the dongle that is located by Whittle.



What do the question marks next to my nodes mean? The question marks shown beside the nodes when running a project in Whittle indicate that there are problems with the Whittle license being used. There are three possible causes of question mark status. 1. The license file (ini file) in use has expired. In this case, contact the support desk – [email protected] for the new license.



2. The license number of the initialization file (.ini file) and the license number of the Whittle dongle do not match. The dongle number is shown on a label on the dongle itself. The ini file contains the license number in the file name example. Contact the support desk – [email protected] to update your license. 3. The project requires a module that is not included in the license file. Contact the Gemcom’s sales team to get an updated license file that includes the module.
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A Quick Tour of Whittle



How do I know if Whittle can see the dongle? The drivers for the sentinel (dongle) are provided by a third party called Aladdin. A Whittle installation includes a diagnostic program from Aladdin. It can be accessed from Start->All Programs->Gemcom Software->Gemcom Whittle->Hardlock->Hardlock Diagnostix as shown below.



Choose the Hardlock menu in the left hand pane. From the right hand pane under Access Mode, select Local (to check for a dongle located on your PC). Type in a Module Address of 6903. To test for a network dongle choose an Access Mode of Network. Finally select the Check Key button on the right. In the example below, the local USB dongle is successfully found in the second line but no dongle is found on the network in the first line (shown in red).
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A Quick Tour of Whittle



The label has come off the dongle. How do I know what the dongle number is? Normally the dongle number is on a label on the dongle. If the label has come off, there is a small DOS program available from supportdesk that can communicate directly with the sentinel and show the number. The program is run from a DOS prompt. Contact the Gemcom support desk if you don’t know the hardlock number.



Page 170 of 316



Exercise 2 – Creating and selecting optimal shells in Whittle



A Quick Tour of Whittle



14. Click on the File outputs tab. Files can be stored in fixed or comma delimited format and some files can be stored as binary rather than text to speed up processing time and reduce hard disk space. The spreadsheet heading setting determines the format of the headings for the files output from schedules and analyses. Note that error messages are given in terse technical codes.



15. When you’re finished with the Preferences, click OK.
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A Quick Tour of Whittle



16. Choose Tools > Show system limits.



Note:



The maximum for the total number of characters in a filename including the path is 256 characters as of v4.3.



License information specific to your ini file and dongle is contained in the Help menu.



17. Choose Help > About.



The example below shows a full license with all modules that expires on 1 April 2008. The license number (3080 below) should match that on the dongle label, however the license number displayed in the form is actually read from the ini file. This screen does NOT show you which dongle number is plugged into your computer, only the number in the ini file.
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A Quick Tour of Whittle



Exercise 2 – Creating and selecting optimal shells in Whittle



Creating the bg project



Creating the bg project 1. Choose File > New.



2. Enter the project name bg_.



Note that the project directory defaults to whatever is specified in the Preferences menu. 3. Click on the browser for the project directory and select the Whittle directory in the training area from the previous exercise.



Note that the working directory should automatically update when the project directory is selected. 4. Click Next.



The next form defines the files to import. For this exercise we have created a mod and par file which is called a Block Model in the form. The option called Surpac model is actually looking for a string file from the older version of the Surpac export function.
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Creating the bg project



The import wizard will now allow nodes to be set up and run within the wizard. We will not take advantage of this option. 5. Select Finish.



Page 175 of 316



Exercise 2 – Creating and selecting optimal shells in Whittle



Creating the bg project



A status message appears showing percentage of the model loaded.



Once the mod file has been loaded, the define element type codes form is displayed. It is possible to change the name of any elements but we will leave it as the default of the first 4 characters of the grade attribute name.
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Creating the bg project



The Define model dimensions form is displayed showing the block dimensions, model dimensions and the co-ordinates in Northing, Easting and RL. Check that these are correct for the Surpac block model at the export size chosen.



The new project is loaded and some nodes are automatically created as part of the import. The project node has been successfully run and has a green tick beside it. Some nodes such as the pit shells node require more input before running and have a red cross.
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Creating the bg project



For this course, the nodes from the slope set onwards are not required and need to be deleted.



1. Highlight the new slope set node and click on the scissors icon to cut that branch.



The fxp file in the title bar now has an asterisk next to it, indicating that the project has been modified but not saved. The project will be saved every time a node is run but no nodes have been run so far.



2. Click on the floppy disk icon to save the project. The asterisk in the title bar will disappear.
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The Project Node



The Project Node The Project node is created whenever a mod file is imported into Whittle and contains three tabs – Description, Project and Messages. The Project tab contains the location of the project directory and the working directory. If you wish to change the location of a project, move the files to the new directory and then change the references in the Project tab.



Validating the Import The process of importing the mod and par files needs to be checked against the data in the Surpac block model. The items to be validated are • • • • • •



Model origin Model dimensions Block size Total tonnes for each rock type Total contained metal Average mcaf, pcaf and total contained metal for a few benches



We will run the block model node which includes a grade and tonnage report. 1. Go to the Block model node and change the node name in the Description tab to 4 x 5 x 4 (many parcels) 2. Check the information in the data pane of each tab. Are the model dimensions, origin and block size correct? 3. In the Formats tab change the Element units to grams. 4. Select Accept.
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Validating the Import



5. Click on the Tonnage Regions tab.



The Def Mass (or default tonnage) applies to any blocks that are not explicitly defined in the mod file and is used by the Reblock and Pit Shells nodes. It is possible to only export part of the model by constraining the export in Surpac and this would require use of the default mass also. If the blocks excluded are air blocks, then the def mass should be 0. If the blocks excluded are waste blocks then enter the single value for tonnage to be applied to all excluded blocks in the tab above. Remember that it is incorrect to exclude a combination of air and waste blocks from the model due to the application of the Def Mass.



Using a default density of 2.75, a block of dimensions 4 x 5 x 4 has a mass of 220 tonnes. 6. Enter 220 in the Def Mass box. 7. Click on formats tab to change the element units as grams. By default the period length is year, if you are working on a small project with life of mine less than a year then change this to month/quarterly accordingly.



Accept the changes. Ensure the block model node is highlighted and select the Run To icon.
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Validating the Import



8. Click on the Summary tab and PARCEL tonnages by rock type and total grams for the model are displayed as shown below:



If some default waste or waste tonnes not included in parcels exist they will not be reported in the summary tab.



Compare the tonnes and contained metal with those from the Surpac report in the first exercise. The difference in tonnage between the Surpac and Whittle model is 1 tonne from a total of 244 million tonnes while the variance in contained metal is 0.001%.



Note the minimum grade in the model is 0g/t and the maximum is 15 g/t as expected.



9. Click on the Report tab and read the report.



Note the warning messages that ore exists at the bottom of the model and the northern edge. We will deal with this later.
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Validating the Import



10. Compare the bench listing for tonnes, grade and contained metal with the report produced in the first exercise.



Has the export been successful?
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Validating the Import



Volume adjustment



If a volume adjustment attribute containing the value of 0.5 for all blocks was included in the export of this data, the summary and report tabs are shown below.



The difference between total tonnage and parcel tonnage is not included in the Summary tab but shows in the report tab as WASTE. Note that the item labeled TOT is only the total of the tonnes within parcels, not the total within the model. It does not include the undefined waste shown as WASTE.
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Validating the Import



Support desk tip



Negative Element Grade



If a parcel in the mod file contains negative element units, the following warning message will be displayed in the pru and message tab.



*** WARNING: File contains negative units Whittle will allow the import and further processing of a parcel with negative units and generate an optimal shell. For this reason, it is vitally important to read the message and report tabs taking note and appropriate action for warning and error messages.



Negative Mcaf or pcaf



The handling of negative cafs has changed in v4.1. For earlier versions, if a mod file containing negative values for mcaf is imported into Whittle the following message is displayed:



*** ERROR: AN ADJUSTMENT FACTOR IS NOT POSITIVE - LINE IS: 1,1,1,1,-1.000,1.007,1760.0,6 occurred at line:



1



The import will abort, the node will display a red cross in the status icon and if the check data box is chosen the following message is reported:



This is a fatal error that must be rectified before further processing can take place.
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Validating the Import



In v4.1, there is a fatal error on import (displayed below) and no further processing can take place. For this reason always use the validate function in the Whittle Export function in Surpac.



Zero Mcaf or Pcaf



The handling of zero cafs has changed in v4.1. For earlier versions, when the pit shells node is run on a model with zero cafs and using the cafs as cost definition, the following error message will be displayed.



*** WARNING: THE MODEL FILE CONTAINED ONE OR MORE ZERO VALUE POSITIONAL CAF FACTORS. The optimisation will complete and produce an optimal shell that mines all blocks with positive grade (due to zero costs). The process time will be much longer than a project with no zero value cafs. For this training data set the optimisation process time will be 10 times longer if zero cafs are included. For this reason, it is vitally important to read the message and report tabs taking note and appropriate action for warning and error messages. Page 185 of 316
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Validating the Import



In v4.1, there is a fatal error on import (displayed below) and no further processing can take place. For this reason always use the validate function in the Whittle Export function in Surpac.



Wrong AIR code



If “air” was entered at the Whittle export form in Surpac instead of “AIR” the mod file is written with an additional rock code containing parcels of zero tonnage. Depending on the value of sg in the air blocks, there may or may not be tonnes in the AIR parcels. The easiest way to check the AIR rock code is correct is to look at the Summary tab of the New Block Model node. The rock code of AIR will be reported as a rock code (when exported correctly air does not appear in this report).
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Validating the Import



Negative Sg



If a mod file containing negative values for tonnage is imported into Whittle no warning or error messages will occur. For the example below, the sg for all OXID blocks was set to -1.8. Whittle has simply removed all of the parcel lines with a rock code of OXID. Processing is able to continue and a result is produced which is incorrect. This situation needs to be rectified before proceeding.
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Grade/Tonnage Graph



Grade/Tonnage Graph For future comparison purposes and to further investigate the project, we will generate a grade tonnage graph.



1. Right click on the Block Model node and Add a Grade Tonnage Graph.



There are two main types of format for the graph: histogram of tonnages within specified grade ranges or as a traditional line graph of tonnes and average grade vs cut off grade.



2. Under Graph type, choose Cut-off. 3. Go to the Definition tab and next to the User defined cutoffs box choose Add Range.



We’ll use a lower cut off grade of 0.5 g/t to avoid the large tonnage of waste material skewing the graph.
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4. Complete the Definition tab as shown below:



5. Accept and Run the node. When completed click on the Graph tab.



6. Click on the magnifying glass to view the graph in detail. Page 189 of 316
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7. Go to the 2



nd



Block Size



Yaxis Preferences tab and turn the au_c grade item off.



8. Do not click on OK as this will exit the larger graph view. Instead click on the Graph tab to show the graph as below:



The Grade Tonnage Graph is a useful tool to view the grade distribution and will be used later in the course.



Block Size There are several block sizes used in optimisation • • •



Geological definition (2 x 2.5 x 2 in this case) Block value calculation which has a minimum size of the selective mining unit (yet to be determined) Sensitivity analysis (aim for roughly 200,00 blocks total)



It is important to complete a sensitivity analysis to understand which the driving factors for the project are and to reduce risk. In order to complete the sensitivity quickly, a larger block size is chosen. The smaller number of blocks will usually give just the same shape of graph with a very small shift of absolute value. The block size for the block value calculation is chosen relative to the smallest mining unit (SMU) to simulate what can practicably be mined. If parcels exist at a size smaller than the SMU make sure the issue of ability to extract the ore at that size has been addressed or combine the parcels within the block. The issue of SMU could affect the block size, mining cost, dilution or mining recovery.
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Reblock In the Report tab of the Block Model node, find the number of blocks and number of parcels that might be processed. This model has 1.2 million blocks and 1.6 million parcels that could be processed. The block size is 4 x 5 x 4 and the parcel size is 2 x 2.5 x 2. The mining costs are based on an excavator and truck fleet that can selectively mine 8 x 10 size blocks on a 4 m bench. The resulting dilution is assumed to be 5% with a mining recovery of 100%.



A block size of 8 x 10 x 8 is chosen for the block value calculation and requires that the model be reblocked to this size with a maximum of 1 parcel per rock type per block. The reblock will result in a total of 300,000 blocks. The sensitivity will be performed on 12 x 10 x 8 blocks giving a total of 100,000 blocks. In either case, the model must also be extended to the north to ensure the optimal pit does not hit the edge of the model. First we will complete the reblock, slopes and optimisation for the sensitivity analysis and then repeat the process for the block value calculation.



1. Highlight the block model node, right click and select Reblock Block Model. 2. Change the description to 12 x 10 x 8 (1 parcel) Used for Sensitivity and add relevant notes especially the assumed fleet.



The Reblock node can be used to add expensive blocks (e.g. some existing infrastructure that would be expensive or impossible to move), extend or truncate the framework or split/combine blocks.



If an optimal shell reaches the edge of a model, the slopes are simply extended vertically as if the extension contained air blocks. The optimal shells should always be checked visually for unexpected results. The Adjust Framework tab can be used to avoid the problem of a shell hitting the edge of the model.



During the reblock program, any block on the side or bottom of the framework is replicated into the nearest blocks in any adjacent extension. Any element content of these replicated blocks is removed but the rock-type, pcaf, mcaf and the tonnage of the parcels is retained. One effect of this replication is to extend any topographic surface horizontally outwards to the limits of the input model framework.
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Zone number is stored in the mod file for each block. If blocks are combined then the zone number of the block with the lowest numerical co-ordinates is selected as the zone number for the new block. 3. Click on the Adjust Framework tab.



We will extend the model 100 metres north and 80 metres west. The tab specifies the number of blocks in each direction (originally 100 x 160 x 75 blocks) Using the block dimensions of 4 x 5 x 4, the model is extended 20 blocks (80/4) west and 20 (100/5) north. The default direction to extend the model is east and north. If the direction is west or south then the model offset options must be used. As we are extending west then the model offset is also 20 blocks to ensure that the blocks are added in the intended direction. The diagram updates after the Accept button is selected.
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4. Click on the Adjust Blocks tab and enter the information shown below:



The blocks can be either combined and / split and the resultant block is given the tonnage of the sum of the component blocks. When blocks are split, the tonnage and element content is shared equally between the output blocks. The number of parcels in each output block is the same as in the original block. Note that the maximum parcels per block is set to 1 so that grades are being averaged within each rock type. Expressions for mcaf and pcaf can be added at this stage however we have no need to change the values already stored in the block model. If you are producing a model where the block size is similar to the selective mining size, you should limit the number of parcels to one for each rock-type. If you are producing a model for use in design or sensitivity work, you have to consider how many parcels you need. Assuming that the grades are different in the different parcels, what is important is to retain a good description of the grade distribution in the model as a whole, so that the tonnage processed will react realistically to changes in cut-off. It does not have to be too detailed in a particular block . This is because the overall mine behaviour is dependent on the grade distribution of groups of blocks rather than that of individual blocks. With a single element, five or ten parcels per rock-type in a block is probably enough. With two elements, one might expect to have to square this, but five or ten is still probably enough. This is because the tonnage discrimination is the same as for one element



5. Select Accept and Run the reblock node. 6. Click on the tabs available now that the node has been run. 7. Check the model dimensions, tonnages, contained metal and grades.



Remember that tonnes have been added so that the total tonnage and tonnage by rock code will be greater than the original. What is the warning message? How many parcels does the new model contain? What is the name of the new model?
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Slopes Slopes are defined in Whittle by structure arcs. The relationship between blocks is contained in the structure arcs file i.e. in the diagram below if A is to be mined, B must be mined however the reverse is not true. If B is to be mined, A may or may not be mined. An arc is formed from A to B.



B Arc from A A All slopes are translated into a large number of block relationships. It is wrong to assume we need an arc from each block to every block which is “above” it. This is because arcs can chain as shown below.



C



B If A is mined so is C A
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The slopes node creates a structure arcs file containing the relationships shown visually below.



Desired Slope



It is possible that the actual slope of the optimal shell is steeper than the desired slope entered. (Although it won’t be shallower) In the example above the structure arcs have been generated 8 benches to the full height of the model. As most models have many more benches, the number used to generate structure arcs can be controlled. The greater the number of benches, the larger the number of structure arcs and the slower the optimisation. The smaller the number of benches for arc generation, the greater the slope error between desired and achieved slope.



The rule of thumb for the number of benches to search in structure arc generation is



(max(x,y) x 8) z where x, y and z are the block dimensions. For this exercise, the max of x and y is 12 and z is 8 so the number of benches should be 12. After running the slope node, always check the slope error and increase the number of benches if the slope error is too large (say > 2 degrees). A large slope error in the optimal shell will mean that the actual pit design can not achieve the tonnes, grade, etc reported in the optimisation.
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Whittle slopes are overall slopes and need to include an allowance for ramps and berms.



Regardless of the definition method for slopes (rectangular regions, zone numbers or rock codes), slopes are stipulated by a bearing. It is very important to note that bearings are given instead of wall positions. Any walls at right angles to the bearings, in a particular slope region, will have the given slope applied. In the diagram below, the slope specified for a bearing of 45 degrees would be used by the program in the positions indicated by the arrows.
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Be careful when stipulating the bearings for slopes as slopes are interpolated between the bearings as shown below.



To ensure the walls have a constant slope, add bearings on either side with the desired slope.



Constant



Constant



Overall slopes for this project were given in the previous exercise and were the same for all bearings within each zone.



1. Highlight the node of the sensitivity model, right click and Add a Slope Set. 2. Change the description and in the Slope Type tab, select Zone numbers in the Model file.
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3. Click on the Profiles tab and at the top of the data pane, select Add Profile. The new profile will appear directly beneath the Add Profile button. 4. Change the slope to 38 and press Enter. 5. Continue adding profiles until the slopes for all six zones have been defined. Note that the benches for slope generation has defaulted to the rule of thumb number for each profile. 6. When the profiles are complete, Accept the data.
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Once the data has been accepted, the slope profiles can be matched to the correct zone number.



7. At the bottom of the data pane, click on the slope profile for zone 1 and select profile 1. 8. When all zones have the correct profile, Accept the data. 9. Click on the Check Data box to ensure the data is valid. 10. Run the slopes node.



The program generated 17.6 million arcs and took several minutes to run. A file with a stu extension (the structure arc file) has been created.



11. Click on the Report tab. What are the average slope errors for the 6 zones? 12. Change the number of benches to 10 for profiles 1, 2, 4 and 5. 13. Rerun the node. Note that the number of structure arcs has dropped to 13.1 million and the process time was reduced. The smaller structure arc file will reduce the process time of the pit shells node.
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At each Report tab, 4 icons are available in the top right corner of the data pane.



The first icon changes the font size of the report, the second performs a search. The third icon will open a print dialog box and the fourth allows changes to the font size to be saved.



Beware of the profile numbering in the Report tab. The first part of the report lists the slopes and number of benches for arc generation by profile using 0 as the default profile number.



Directly beneath the above section, a plan view and the slope errors are listed for each profile using 1 as the default profile number. In the error listing the profile numbers are increased by 1.
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Support desk tip



Process Time



The factors affecting the process time for structure arc generation are:



•



Number benches used for structure arc generation (more = slower however this must be weighed against the slope error)



•



Block dimensions (block geometry relative to slope angle)



•



Height of profile (higher can = slower)



•



Slope method used (rectangular = faster, complex rock/zone=slower)
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For any project, you will not know what the “ideal” number of arcs is (because of the factors listed above) and the focus should be on the slope error rather than the total number of arcs.



Generally, aim for an average slope error of between 1 and 2 degrees. Any less than 1 degree is probably generating an unnecessarily large structure arcs file for no advantage and will slow down the process time of both the structure arc and pit shell generation. A shallow slope angle (say less than 35 degrees can produce slow process times but it is not usually an option to change the desired slope angle)



What about blocks in Surpac that have different zone numbers in the sub-blocks?



In the mod file, the zone number is stored in the block line NOT the parcel line. During the export in Surpac, if a Whittle block contains blocks or sub-blocks with different zone numbers, then the zone number with the highest cumulative tonnage within the Whittle block is used.
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Support desk tip



What does the error message below mean?



In the above case, zone numbers have been used to define the slopes. If the slopes are defined using rectangular slope regions, the error message below may be displayed.



The above error message has been caused by the IJK definition of the regions being the same value. Whittle interprets this situation as the regions overlapping.



The figure below shows an example of slope regions which overlap.



This problem can be resolved by entering the value of 161 for the Min Y field of region 2.
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No Zone numbers in Mod File



If the mod file is accidentally created with no zone number and the slope method is chosen as zone number then the bottom box of the Profiles tab will only have zone 0 listed (the default) and no others can be added.
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Exercise 2 Assessments What are the 2 elements to Whittle security? Where is the ini file defined in Whittle? What is the fxp file? What type of tonnage will not be shown on the Summary tab of the Import Block Model node? What values are contained in blocks added in the Reblock node?



Exercise 2 Assessments What is the minimum number of parcels possible per block? What is the target number of blocks for sensitivity purposes? What is the target slope error in degrees? Is the zone number stored in the parcel or block line of the mod file?
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Pit Shells Revenue Factors



So far we have gathered data for costs, recovery, mining and processing limits and slopes that, coupled with a gold price, would produce a single, optimal pit.



VALUE = (METAL x RECOVERY x PRICE – ORE x COSTP) – ROCK x COSTM METAL = units of product eg ore tonnes x grade RECOVERY = Proportion of metal recovered from processing PRICE = the price per unit of product sold ORE = tonnes of ore in a parcel COSTP = the extra cost of mining a parcel as ore and processing it ROCK = total amount of rock (ore and waste) in a block COSTM = the cost of mining a tonne of waste



The block value formula above determines the value of the block which utilises a single value for each input and gives a single result e.g. pit A shown below.
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If we increase the metal price, the value of every block within outline A will increase or stay the same. No block value will go down. Consequently, every block within outline A is still worth mining. In addition, if we do another optimisation using the new values, the new outline, shown as B below, is certain to include the whole of A. It may also include extra blocks that were not worth mining before, but which now are worth mining.



Consequently, if we step the prices through a series of values, doing an optimisation for each, we obtain a set of nested pit outlines, and this is, in effect, what the Pit Shells node in Whittle does. It multiplies all of the prices by a series of "Revenue Factors" ranging, typically, from 0.3 to 2.0, and produces a pit outline for each.



The reason for producing outlines for the smaller values of Revenue Factor is that we want to produce inner pit shells to highlight the best positions to start mining and to assist with the sequencing. The outer pits can help determine a less risky location for infrastructure such as waste dumps or processing plant.



The outlines are usually very close together and form an almost continuous "spectrum", where the change in tonnage from one outline to the next is quite small. However, if the grade increases sharply with depth or the ore body is discontinuous, large tonnage differences between adjacent pits can occur.
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Since all the outlines obey the pit slope requirements, it is simple to determine what sequences are permissible when mining out a particular pit.



Inner pit shells show where it is best to begin mining Intermediate pit shells show possible practical pushbacks Pits near RF of 1 are used for sensitivity and risk analysis Higher RF pit shells show possible future expansions



Revenue factors can be entered as a range with a start, end and step or single values or a combination of both. The user can choose from two methods of revenue factor range generation: fixed intervals or geometric intervals. The fixed intervals, as the name suggests, provide a constant step size in revenue factor. The geometric intervals allow a user to specify the required number of factors but will then produce more pits in lower revenue factors and less in the higher factors (handy if looking for starter pits as well as a final pit). This is illustrated in the figure below.
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The generation of pit shells involves simple cashflow (is not discounted) and does not take into account the time value of money or when a particular block is mined. The optimal shell assumes that all blocks are mined today.



Ore Selection Method



Whittle has two methods of selecting parcels for processing and determining whether a parcel is ore or waste. It can use cut-offs or cash flow.



When ore selection is by cut-off, ore is selected by comparing the grades of the material with precalculated processing cut-offs. If it does not satisfy the cut-offs, it is treated as waste. In the case of multiple processes, the first eligible process is used. The grades are compared with the cut-offs of each in turn, in the order in which they are specified in the Block Model node. For an explanation of how multiple cut-offs are handled, see the online help.



When ore selection is by cash flow, ore is selected by comparing the cash flow which would be produced by processing it and the cash flow which would be produced by mining it as waste. If the cash flow from processing it is higher, the material is treated as ore. If not, it is treated as waste. If more than one processing method is applicable, the one which produces the highest cash flow is used.



In the simple cases (one process, no block co-ordinate based expressions affecting cut-off), ore selection by cash flow will produce the same result as that produced by the use of marginal cut-offs. However there are some cases where this is not true.



Cut-off calculations are based on processing cost, element processing cost, price, selling cost and recovery and are calculated in a preprocessing stage before individual blocks are considered. If any of the items are based on expressions that: • •



are based on block position (IX, IY, IZ) or are based on grade of another element



then a user must use ore selection by cash flow, because the marginal cut-off, determined for the whole mine, cannot be calculated.



In the simple case of a single process and no expressions, these two mechanisms should produce the same result. In the case of multiple processes, where the cut-offs are not ranked, then you must use ore selection by cash flow; if you want to use ranked cut-offs, you must use ore selection by cut-off.



For a simple case, such as ours where the ore selection method does not affect the destination of a block, note that selection by cut-off includes the cut-off grade for each rock code in the report file. This cut off is based on the data for the reference block of that particular rock code. If pcafs are used, which is true in our case, the cut-off grade shown in the report is NOT correct for any block with a pcaf that is not 1. Value mode is where the block value is either stored in the block line of the mod file or calculated from the parcel values defined by the element indicated to store the parcel value in the user element tab. Both ways of defining the block value require the VALU module and are not covered in this course.
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When ore selection is by Profit mode, the parcel revenue element is used to determine the process path which will return the best cashflow. In simple situations, the results are identical to ore selection by cashflow but profit mode has the ability to be used in Stockpile and Cut-Off Optimisation (SPCO) for multiple processes.



Adding a Pit Shells Node



1. From the Slope Set node, right click and Add a Pit Shells node. Note that the new node icon has a red cross and requires further input before processing. 2. Click on the Mining tab and enter the information shown below:



Note that 5% dilution is entered as 1.05. If there was a mining recovery of 5% it would be entered as a factor of 0.95. If both mining dilution and mining recovery are used, the order of application does not affect the result as mining dilution affects the grade but mining recovery does not. The rock type cafs are not used as we have given the mcaf in the model file. It is possible to give the costs as $/BCM not $/t but we have used $/t. Also note that the Rock type mining CAF defaults to 0 which is an invalid CAF. Ensure the CAFs are 1 but the Rock type Rehab cost is actually a cost and should be left at 0.



3. Click on the Processing tab and select Add. 4. Enter the information for the HCAP rock code. We only have one method of processing the ore so we’ll call it MILL and we’ll use cut-off for the ore selection. The reference processing cost for all rock codes is 16.79. 5. Select OK.
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6. Copy the first process definition to create entries for all the rock codes as shown below:



7. Click on the Selling tab. The gold price for this project for strategic mine planning purposes is $AUD855/oz. Remember that the units for all prices must be consistent with the gold grade units (gold price becomes $27.5/g). This project also has a 2.5% State government royalty.



Any royalties or other selling costs could be included in the Sell Cost box. However the revenue factor only scales the metal price. If the selling cost is proportional to the selling price (as with a royalty) it is better to include it in the selling price. For this project the sell cost is $27.5/g x 97.5% = $26.81/g.



8. Complete the pane as shown below.
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9. Click on the Optimization tab. Most of the settings in the Settings pane minimise the run time of the optimisation. Given the state of hardware today, there is never normally a need to do this. It is possible to optimise using all blocks, only blocks in a sub-region or only blocks defined in the model. In this case the first and third options are the same and the second is not relevant.



It is possible to include or exclude air blocks from the optimisation to speed up processing time. If air blocks are not included then the output can not be used in the Minimum Mining Width node. There is also an option of which air blocks to include in the output file after processing. Only the option to include all air blocks will allow use with the Minimum Mining Width node.



An example of the requirement to include air blocks is shown below:



When you run a Pit Shells node, the background process periodically dumps all of the data from memory to a temporary Work file to enable a later restart. This can be extremely helpful if, for example, a long optimization run is terminated because of power failure. The restart interval determines how often the dump occurs. If the power source is unreliable or the run time is expected to be very long, the restart functionality can be a lifesaver.



The Optimization Control allows the user to limit the number of iterations taken before results are produced. If the Maximum Iterations are specified, the result will NOT be an optimal shell.



The default setting for a new pit shells node is 86 revenue factors (0.3 to 2.0 using 0.02 steps). This high number of revenue factors could potentially take a long time to process so we’ll only use one revenue factor for a quick first pass.
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10. Under the Produce Nested Pit Shells heading, highlight the existing revenue factor range and click on Delete on the right hand side. 11. Click on Add Single and choose a value of 1.0.



12. Ensure the remainder of the tab is completed as shown below:



Bench Phases are used when the mod file contains the value for the block (called a Value model which requires an additional module) rather than the metal and tonnes (as we have used). With the Value option, revenue factor ranges are not available, so an alternative is used to produce the pits. Initially, the top bench only is considered for optimisation. A pit optimisation is performed and if there are any blocks worth mining, this constitutes a pit shell. Next, a bench is added (now considering the top two benches). A pit optimisation is performed and the result constitutes a pit shell.



Therefore, in the example below, the first pit produced is the starter pit on the top bench. The second pit is the one which first uses block(s) on the second bench. This process continues until the last pit which uses the blocks on the last bench.
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13. As we don’t have any constraints, additional blocks, need to change the cafs or user defined elements, select Accept. 14. Change the description to make it easier to identify e.g. Sensitivity RF 1. 15. Run the node. 16. When the run is complete, click on the Output tab. A brief summary appears which shows that the optimal pit at the nominated gold price has 3.4 million tonnes of ore @ 1.63 g/t with a strip ratio of 4.31:1. Note that there was only 1 revenue factor so the pit is given a number of 1. If there were 10 revenue factors they would be given numbers 1 – 10 in increasing order of gold price.



17. Click on the Report tab and note that tonnes and grade by bench for each pit is shown as below. What are the cut off grades for each rock type? Note that these are only the cut off grades for blocks with a pcaf of 1. What are the warning messages?
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Beneath the cut off grade display, the total tonnes, tonnes processed and grade processed are listed by bench starting with the highest bench (38 in this case)



18. Click on the Messages tab. 19. Find the name of the res file. The output from the pit shells node is the res file which is the mod file with a new header section and an extra column containing the number of the smallest pit the revenue factor is part of. Note that if the Use Binary Files option is ticked in File -> Preferences -> File Outputs, then the extension of the results file is rzp not res. An example of a res file is shown in a text editor below.
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20. Again click on the output node and select the Open in spreadsheet button on the toolbar.



The output has been dumped to a csv file and opened in Excel as shown below:



21. From the toolbar, select the Three D Viewer button.



22. At the data display box, select only the grades as possible viewing data.
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23. In the pit display pane, tick the Show Pit box and increase the pit number to 9. 24. In the data control pane, tick the Show XY box and increase to the 344 bench. 25. Click on the au_c tab and select Show to display a floating legend. Left mouse within the viewer space will rotate the display, left and right mouse will pan and left and middle mouse will zoom. The Viewer is shown below:



26. Check that the pit does not reach the edge of the model by selecting the Show Topography box.
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The pit has not reached the edge and on the western side the extended topography is highlighted by the flat area extending west to the edge of the model.



To change the colour range, click on Scale.



Choose Add.
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Complete the Palette Name and Type and then choose Add Gradient



After selecting OK, it is possible to use the Edit button to change each range if desired.
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27. Run the pit shells node again but use a revenue factor range of 0.2 to 2 in steps of 0.1. 28. Click on the Optimization tab and delete the single revenue factor. 29. Select Add Range and complete the form as shown below:
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30. After filling in the Start Factor and End Factor boxes, click on auto next to the Number of Factors and then enter a Step Size of 0.1. 31. Select OK. 32. Change the node description to Sensitivity RF 0.2 – 2.0. 33. Run the node again. 34. Check any errors in the messages tab. 35. Check the results in the Output tab. The optimal shell now has a pit number of 9 (ninth in the revenue factor list) with the same physicals as the previous run.



36. Click on the Report tab and note that tonnes and grade by bench for each pit is shown as below. 37. Find the cut off grades for pit 9. What are the warning messages?
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The output has been dumped to a csv file and opened in Excel as shown below:
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38. Open the viewer and notice that the pits can be stepped through by using the up and down boxes beneath Show Pit.



Support desk tip



The factors affecting the process time for pit shell generation are:



•



Number of blocks (more = slower)



•



Number of parcels containing metal (more = slower)



•



Number of structure arcs (more = slower)



•



Number of revenue factors (more = slower)



•



Complexity of process paths (more = slower and expressions = slower)



•



Mcaf definition method and complexity (more complex i.e. expressions = slower)



•



Pcaf definition method and complexity (more complex i.e. expressions= slower)



For the first run on a project, use large blocks (~200,000 total) and a small number of revenue factors (say less than 20). Smaller blocks and more revenue factors can be used in subsequent iterations. The geometric interval definition is a good way of focusing on starter pits as well as the final pit. Negative Tonnes



If a mod file containing negative values for tonnage is imported into Whittle no warning or error messages will be given and a result will be generated. For the earlier example of setting all values of OXID tonnage to negative, the revenue factor 1 pit is shown below:
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The total and ore tonnes are reduced by the amount of OXID and the shell is generated as if blocks containing only OXID are actually AIR blocks. This result is incorrect.



Exclamation mark on pit shells node for status icon



A red exclamation mark on a yellow background next to a node means the node has aborted unexpectedly. When this occurs and an attempt is made to run the node again, a message like the example below may appear in the Messages tab:
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*** RESTART IS NOT POSSIBLE DUE TO THE STATE OF THE WORK FILE ^^^DELETE GENERATED FILES FOR THIS NODE AND RERUN



To enable the node to be rerun, the work file must first be deleted. This is done by right clicking the node, and selecting Other – Delete Generated Files as shown below:



You can also use the delete generated files menu command at any time to delete all the outputs from a node and reduce the size of the working directory. Once the generated files are deleted, the results of the analysis cannot be viewed until the nodes have been re-run.
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Operational Scenario The Operational Scenario node is used to define most of the settings required for a schedule, pit by pit analysis or any other form of analysis. Most settings are similar to those that appear in the parent Pit Shells node and default to those values. It is the first place in the optimisation process where time is applied by limits on mining, processing or elements and financial parameters like discount rate, capital costs and explicit time costs.



The discount rate is used to calculate Discounted Cash Flow analysis. This discount rate may include not just the time value of money expected but also an adjustment for the risk or opportunity cost of the project.



For the purpose of generating pit shells (and cut-off calculations), time costs must be implicitly included in the mining, processing and/or selling costs. However, for the purposes of cash flow analysis and Discounted Cash Flow analysis (which follow on after the operational scenario), it is more useful to show the time costs explicitly. In order to achieve this, you should: • • •



Perform the optimisation (pit shells node) with time costs in the mining, processing and/or selling costs included implicitly. In the operational scenario enter the replacement capital cost In the operational scenario enter the costs identified as explicit in the Explicit Time Costs section



Note that the time costs that are factored into the mining, processing and/or selling costs should be applied against the item that is the limiting factor of the optimisation. Otherwise the intended time cost value will not be correctly incorporated in the final result. Note also that different periods could have a different limiting factor.



1. From the Pit Shells node, Add a Scenario. Note that the Mining, Processing, Selling, Expressions and User Elements tabs are the same as those in the Pit Shells node with one important difference. The Operational Scenario tabs now have a clock icon instead of the expressions icon to show that those inputs can be varied for each period. The inputs can still be expressions as well as values but the input can be defined for each period. The period of the project is defined in the original Block Model node in the Formats tab. The period defaults to a year although other allowable inputs are 6 months, 3 months and one month.



2. Change the Description to indicate the mining limit of 9 million tpa and processing limit of 800,000 tpa. 3. Enter the limiting values into the Limits tab.
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Operational Scenario



4. Change the values in the Throughput factors to 1 for all rock types. The throughput factor is the relative speed of processing for a particular rock type. e.g. A rock type which is easy to crush might have a throughput factor of 1.2, and this would be allowed for when applying milling throughput limits



The time cost in the optimisation was $1.5 million pa which was included implicitly as $1.88/t ore processed. In this node, that value will be defined explicitly for the financial analysis that will follow. 5. Enter the information shown below:



6. Accept the data and run the node. There is no output from the Operational Scenario node. The project is simply ready for further analysis, scheduling, etc.



The work flow for the next section will be • • • • • • •



Spider Graph for project sensitivities Pit by Pit Graph for best and worst case to choose a starter pit and final cutback (pushbacks) Schedule Graphs to check schedule of cutbacks by period Add a new Operational Scenario with different limits Pit by Pit Graph to choose starter and final pits Schedule Graphs to check schedule of cutbacks by period Continue cycle of operational scenario with different limits, pit by pit graph and schedules until a starter pit, final pit and limits are chosen



Depending on the study requirements, other steps could include selecting the best cutback with Pushback Chooser, Scheduling with Buffer Stockpiles, modifications for Minimum Mining Width or Cut off Grade optimisation. This course is not intended to cover any of these options. Contact your local Gemcom office if you are interested in an Advanced Whittle Techniques course.
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Spider Graph



At the completion of the above steps, we will select the two pits for further work. We will then run the slopes, optimisation and graphs on a block model for design purposes which will result in the export of two shells for use in Surpac.



Spider Graph Knowing which inputs a project is sensitive to is at least as important as knowing what the NPV of the project will be. Determining which inputs are the most sensitive allows those inputs to be reviewed and the project risk to be reduced. There is no point in spending days gathering mining cost data when the project is insensitive to it. Sensitivities are generally tested by varying one input at a time and quantifying the effect on a project measure. Often the project measure will be NPV or mine life or metal produced depending on the driver for the corporate objective. The definition of “sensitive” varies but one rule of thumb is a project where the measure varies more than 25% when the input is varied 10%.



Note that all the Whittle functionality used to date, is included in the foundation module. Spider graphs are included in the Advanced Analysis Module (Adva). The modules for the license being used can be displayed by selecting the Help menu and About option. The info is displayed as shown below:



The spider graph allows very quick generation of the effect of multiple inputs on against a user defined measure. 1. From the Operational Scenario node, Add a Spider Graph.



Page 229 of 316



Exercise 2 – Creating and selecting optimal shells in Whittle



Spider Graph



Since the final pit mine life is relatively short, we will generate sensitivities on a final pit of pit 9 with no cutbacks. The schedule tab is common to all graphs and analysis nodes but for each application, not all fields are applicable. The specified case scheduling algorithm only affects results if a result for the specified case is chosen in the Definition tab.



2. At the Definition tab, Add the inputs to be tested as shown below:
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Spider Graph



Note that items involving rock type can only be varied one at a time e.g. the processing cost can only be varied for fresh or transition rather than all varied at once. Also note that slopes must be run manually. For presentation in reports and flexibility, it may be easier to vary some of the inputs manually and dump the results to csv for graphing within a spreadsheet. The graphing functionality of Whittle is not as comprehensive as a spreadsheet or dedicated graphing software and it is suggested that the Spider Graph node is used to quickly determine the sensitive parameters but not for presentation purposes.



This schedule assumes a top down sequence with no cutbacks and that is called the Worst case in Whittle (see discussion in next section) The value to display in output is Discounted Open Pit Value for Worst Case. Vary the items by 10% and set indicators to 15%.



3. Run the node and then go to the Graph viewer.
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Spider Graph



Typical of a gold project the most sensitive input tested is gold price. The next sensitive input is mining dilution followed by metallurgical recoveries. The project is less sensitive to mining capacity than mill capacity which is expected in a project that is milling limited. The fact that mining dilution is the second most sensitive input may indicate the need to revisit the way dilution is defined and further work to establish the likely value.



No inputs caused a variation in NPV of 25% or greater so the project is not particularly sensitive to any one input.



Apart from the graph shown above, the spider graph node generates a csv file (with a single column of data) and a print file as shown in the Report tab.
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Spider Graph



Support desk tip



Be careful when selecting values to vary. If you choose an input that is illogical such as the limit on gold produced (au_c throughput limit)when there is no limit set in the operational scenario, Whittle displays an error message similar to below and puts a red exclamation mark next to the node. *** Invalid value or range



*** THE INPUT LOG FILE IS NOW OUT OF STEP WITH THE QUESTIONS



*** INPUT NOT ALLOWED - PROGRAM ABORTED



*** INPUT NOT ALLOWED - PROGRAM ABORTED



It is also invalid to use a value that is based on complicated expressions or one that changes with time.
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Assessment



Exercise 2 Assessments What causes the nested pit shells in the Pit Shells node? Where is the reference mining cost entered in Whittle? What number range should the mining dilution be? What number range should the metallurgical recovery be? What is the cut off grade shown in the Report tab of the Pit Shells node?



Exercise 2 Assessments What affects the process time of the Pit Shells node? What are the 2 ore selection methods? What are implicit costs? Where is the Discount Rate entered in Whittle? What is the number for % change in value to measure against for a sensitive parameter?
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Sequencing and Scheduling



Sequencing and Scheduling In order to determine the optimal pit, the sequence and schedule of the pit and any cutbacks (pushbacks) must be defined. The time value of money will affect the optimal pit shell/s selection. So far only a simple cash flow analysis has been performed.



The sequence specifies the ORDER in which mining occurs. In the diagram below, will we mine pit 5 (in red) or will we mine pit 1 first and then pit 5. We could also mine pit 1, then pit 3 then pit 5.



Once the sequence is chosen, the schedule can be developed. The schedule allocates the parts of the sequence to time periods. The schedule determines when the cashflow occurs. The optimal pit is not known until a schedule is completed.



The 3 types of sequences available in Whittle are 1. best 2. worst 3. specified



Imagine a final pit to be mined with a series of possible smaller intermediate pits in cross section as shown below:
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Sequencing and Scheduling



In the worst case scenario, no intermediate pits are mined. The final pit is mined top down, bench by bench.



Top Down Mining



This sequence is almost always feasible (and simple) to mine. Over the life of the mine, waste is mined early while most of the ore is mined towards the end. The high cashflows occur at the end of the mine life and hence give the worst NPV.
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Sequencing and Scheduling



In the best case scenario, each pit is mined out before the next pit is started.



Depending on how many revenue factors were chosen, the sequence is not normally feasible (cutback width less than minimum mining width, access is a problem, vertical rate of advance is not achievable, etc). The waste and corresponding ore are mined in a similar time frame so the cashflows are brought forward and occur closer to the start of the mine life.



Inner shell



The specified case lies somewhere between the best and the worst. The user specifies which cutbacks to mine to gain the advantages of higher cashflow of the best case while still being practical and feasible. The NPV lies somewhere between that of the best and worst case.



?



?



?
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Pit by Pit Graph Initially we will generate a pit by pit graph for the best and worst case, knowing that the reality will sit somewhere in between. The graph will show ore and waste tonnes and NPV to allow selection of a starter pit and final pit. This node can be used to generate a large amount of graph types or even just to produce a csv for manipulation in a spreadsheet program.



1. From the Operational Scenario node, Add a Pit by Pit Graph. 2. Go to the Schedule tab.



This tab is found in all of the graph and analysis nodes. The Final Pit pane is greyed out as the Definition tab will over-ride the input. It is possible to define a specified schedule but as we are yet to choose the starter and final pit, there will not be a specified case. As we are not using a specified case, the section beneath Specified Case Scheduling Algorithm and Specified Case Pushback Definition are irrelevant. 3. Leave the defaults for the Schedule tab and go to the Definition tab. The default values are shown for the definition. 4. We will graph all pits so leave the default of pits 1 to 0 in a step of 1. 5. Delete the values to display until only those shown below remain.



6. Run the node
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Pit by Pit Graph



If the throughput factors are not set (still at the default of 0) in the Limits tab of the Operational Scenario, the Pit by Pit Graph node will not run.



7. Go to the Output tab of the Pit by Pit Graph.



Note that there is no difference in the mine life of the best and worst case until the mine life is greater than 4.3 years. The mine life of the pits around revenue factor of 1 is about 4 years and there are several pits of mine life between 0.4 and 2 years which could be starter pits. The difference in cashflow between best and worst case for pit 9 is around $3.5 million. The actual achieved schedule will lie somewhere between the best and worst case.



8. Go to the Graph Tab and select the magnifying glass icon.
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Pit by Pit Graph



A larger view of the graph is shown.



9. To make the graph easier to read, go to the Display Preferences tab and change the Scaling Factor for the Y Axis to millions. 10. Selecting the OK button closes the graph viewer. 11. To go back to the graph, click on the Graph tab. nd



12. In the 2



Y Axis Preferences tab change the tonnage scaling to millions.
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Pit by Pit Graph



Notice how flat the value curves are around the revenue factor of 1. Even for the worst case, the difference in NPV between pits 7 and 10 is less than $1 million in a total of $42 million. Conversely the difference in ore tonnes is 500,000 t (0.6 years milling) of 3 million total tonnes. If the corporate objective was maximum mine life then pit 10 might be chosen. If the corporate objective was lower risk through decreased exposure to variation in gold price or lower geotechnical risk through shorter mine life then pits 7 or 8 might be chosen.



Also note an obvious jump in stripping ratio between pits 11 and 12. Looking at a starter pit, there are several jumps in stripping ratio between pits 2 and 4.



The actual cashflow will lie somewhere between the best and worst case. The highest NPV for the worst case scenario is pit 8. For this exercise, we will investigate pit 8 for the final pit and pit 4 for the starter pit as it has a low strip ratio for 1.7 years of milling.



The output of a Pit by Pit Graph node is a csv file of the results shown in the Output tab and a print file.



13. Exit the Graph Viewer by choosing OK. 14. Go to the Summary tab and display the summary for pit 8.



The pit utilisation in the summary above is 72.4%. The formula for pit utilisation is shown below:



Pit util% = recovered metal*100/(metal input + rejected)



Rejected material is material for which there is a processing path (i.e. a method/rock-type combination) but which is not processed because its grade is not high enough. The pit utilisation is a combination of metallurgical recovery and the contained metal in parcels beneath the cut off grade.
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Pit by Pit Graph



Support desk tip For a given pit shell, why are the ore tones reported in a pit by pit graph node different to the ore tones reported in a pit shells node?



The ore tones in a pit shells node are calculated based on the metal price equivalent to the revenue factor for each pit while the pit by pit graph uses only one metal price chosen in the $ node for all pits. Example In a pit shells node, for a base prices of $1000/oz, the pit with a revenue factor = 0.5 uses a cut off/cashflow decision based on a gold price of $500/oz. If a $ node is added with a gold price of $1000/oz and a pit by pit graph node is then run, the pit with a revenue factor = 0.5 uses a cut off/cashflow decision based on a gold price of $1000/oz and not $500/oz. Hence the cut off grade for that pit in the pit by pit graph is lower than that used in the pit shells node and the ore tones are greater in pit by pit graph. In the case of a pit with revenue factor > 1, the reverse is true i.e the ore tones are greater in pit shells node.



Note that the Waste (other) value is negative. Negative waste tonnages and strip ratios are possible due to the way dilution is applied. When a mining dilution is specified, the ore tonnes within the block are increased while the metal content remains the same. To ensure the total tonnes are correct the waste tonnes are decreased by the amount that the ore tonnes are increased. On benches where there is little or no ore, the waste tonnes will be negative.



There are several ways to deal with this issue.



• • •



The preferable way to handle dilution is within the block model in Surpac. Dilution skins can be applied or changes in block size can simulate dilution. Very small negative tonnages can simply be zeroed. Larger negative waste tonnes can be zeroed and the ore tonnage decreased by the negative amount to ensure integrity of the total tonnes. In practise, benches of all ore are not likely to have additional waste mined as this would mean mining outside the design.



A fourth option to avoid using dilution factors is to use reblocking in Whittle to simulate the effects of dilution. If the reblocking function is used with a maximum number of parcels of 1, the amount of material above a certain cut off grade can change. To quantify the changes due to reblocking we will use a grade tonnage graph.
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Grade Tonnage Graph We are going to generate a second grade tonnage graph to compare to the 4 x 5 x 4 graph at an approximate cut off grade of 0.75 g/t.



1. Highlight the green block model node called 12 x 10 x 8 (1 parcel) Used for sensitivity.



We are going to Add a Grade Tonnage Graph beneath this node. Although we could create a graph as we did the first time, it is quicker and easier to simply copy the first graph.



2. Highlight the first Grade Tonnage Graph and choose Ctrl C to copy the item. 3. Now highlight green block model node and choose Ctrl V. 4. Change the description to 12 x 10 x 8 Grade Tonnage Graph as shown below.



5. Run the node. 6. Click on the Graph tab and then the magnifying glass.
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Grade Tonnage Graph



7. When you have finished with the graph select OK. The output from this node can be imported into a spreadsheet to give the total of 3.73 Mt @ 1.74 g/t for 209 koz above a cut off grade of 0.75 g/t.



8. Compare the grades and tonnages for each block model above a cut off grade of 0.75 g/t.



Item



Tonnes



Grade



Ounces



4x5x4



3,519,177



2.15



243,475



12 x 10 x 8



3,730,928



1.74



209,268



211,751



-0.41



-34,206



6%



-19%



-14%



Variance %
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Grade Tonnage Graph



The change in block size has resulted in a 6% increase in tonnes and a 14% decrease in contained metal. When applying the dilution factor in Whittle, the tonnes are increased, the contained metal stays the same and the average grade decreases.



Given that we have also included a dilution factor in the optimisation of 5% and that the project is sensitive to the dilution factor it may be prudent to review the method for defining dilution and choose to use either the dilution factor or the reblocking. The 12 x 10 x 8 block size has been chosen to determine sensitivities in our case and was not intended for final results. However when we do generate the final pit optimisation, we will investigate the amount of dilution represented in the reblock and then decide whether to use a dilution factor or not.
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Schedule Graph The schedule graph node generates graphs and csv output for the defined inputs by period. The node also produces a msq file which is similar to the mod file with 3 extra columns. First we’ll generate a simple worst case schedule of pit 8 to define the lower threshold. 1. At the Operational Scenario Node, Add a Schedule Graph. 2. At the familiar Schedule tab, choose a Worst case schedule for pit 8.



3. Accept the defaults in the Definition tab and Run the node.
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Schedule Graph



The Schedule Graph node has generated a csv file of results shown in the Output tab, a graph and a summary for the total pit. These three items are shown below:



Note the large amount of waste mined in the first year in the graph below.
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Schedule Graph



The node has also produced a mining sequence file (msq file). The file has the same format as the mod file except:



• •



In the block header line the zone field has been replaced by the period, fraction and pushback fields In the parcel line the destination of np (not processed) or MILL is added



Looking at the graph above, the mill is filled each year but the mining capacity is not reached in any year although the first is close. This certainly has potential to defer waste stripping and increase the NPV.
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Schedule Graph



4. To investigate which benches are mined in each period, add a Bench Schedule beneath the Schedule graph. 5. Accept the default values and run the node. The Output tab shows that only one “pushback” is mined i.e. pit 8 top down. The bench RL column slowly decreases as the period increases until the end of year 5. The negative waste tonnes are also seen in years 4 and 5.



The only output from the Bench Schedule node is a csv file containing the results shown above.



6. Ensure the Schedule graph has been named Pit 8 Worst. We are about to add many Schedule Graph nodes under the Operational Scenario and the node names will become important for distinguishing the various schedules.



7. Copy the Pit 8 Worst nodes for schedule graph and bench schedule. 8. Call the copy Pit 8 Best and change the Case to Best in the Schedule tab.
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Schedule Graph



9. Run both the schedule graph and bench schedule nodes.



The bench schedule output (below) shows 8 pushbacks (pits 1 – 8) mined consecutively. Each pushback is mined from top bench to bottom bench and then returns to the top bench for the next pushback.
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Schedule Graph



A comparison of the two graphs shows the difference in the timing of waste mining. The graphs have been resized so that the Y axis scales are similar. This highlights the large amount of waste the Worst case schedule mines in the first year.



Using a final pit of pit 8, these two schedules represent the worst and best extremes. Now we will start using specified schedules with a final pit of pit 8 but with 1 starter pit.
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Exercise 2 Assessments What is a “best” sequence? What is a “worst” sequence? Describe a “fixed lead” sequence Where is the Discount Rate entered in Whittle? Which of the best and worst sequence is usually achievable? Which has the highest NPV?



Exercise 2 Assessments



What causes negative Waste (Other)? What is another way of dealing with this issue? Which node creates a res file? Which node creates an msq file? What is on the x axis of a schedule graph? What is on the x axis of a pit by pit graph?
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Milawa



Milawa



Typical Pit by Pit Graph



Scheduling will make a difference Need to find a practical schedule



Milawa determines what to mine in each period



?



?



?
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Schedules



Best - each pit shell as a phase Worst - bench by bench Specified - constant lag between each phase Milawa NPV – finds a sequence that improves the NPV of the project within the mining and processing constraints. Milawa Balanced – finds a sequence that improves the throughput balance of the mining and the processes



Worst Case schedule Bench by bench



1 2 3 4 5 6 7 8 9 10 11 12 13 14 15 16 17



Provides a lower bound to NPV - generally practical
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Milawa



Best Case schedule



Pit by Pit



1 2 3 4 etc



Provides an upper bound to NPV - generally not practical



Specified schedule



Fixed lag, equal advancement on all active phases.



Page 255 of 316



Exercise 2 – Creating and selecting optimal shells in Whittle



Milawa



Milawa Algorithm



Ph 1



Ph 2



Ph 3



Amount per phase calculated to improve NPV or throughput balance



Possible Milawa Inputs



Number of cutbacks (shells) Maximum number of benches per period Economic parameters for calculating values Mining, Processing and selling limits Any user controls over the lead between cutbacks
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Milawa



Milawa Algorithm Allows full user control



Max benches per period



Max lead Min lead



Milawa Rules



Mining in the next cutback can never advance ahead of the current cutback Applies any user defined controls over the separation between the cutbacks and the number of benches that can be mined per period. You can mine part of a bench in a period All mining in a cutback is assumed to occur at the same rate
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Milawa The algorithm then EITHER calculates NPVs or Balances for possible schedules and searches the domain of feasible solutions . It does not generate and evaluate ALL feasible schedules but samples the feasible domain until it converges on its solution.



Milawa – NPV



Takes the user specified push-backs Searches to find what should be taken from each bench to maximise NPV
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Milawa



Milawa Balanced



Takes the user specified push-backs Searches to find what should be taken from each bench to maximise throughput Will sacrifice NPV to achieve a better throughput balance. Up to user to decide whether cost is worthwhile



Case Study 1 - Changing Rates



Throughput Rates



Tonnage (m)



40 30



Processing Mining



20 10 0 1



2



3



4



5



6



7



8



9 10 11 12 13 14 15



Period
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NPV vs Tonnage NPV and Tonnage 1000



500 Waste Ore Best Worst



900 800



400



300



500 400



200



Tonnage (m)



600



300 200



100



100 0



0 1



6



11



16



21



26



31



36



Pit Number



Worst Case Sequence Worst Sequence 40



Waste



35



Ore



2.5



30



Cus



2.0



25



1.5



20



1.0



15 10



0.5



5 0



0.0 1



2



3



4



5



6



7



8 9 Year
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10



11



12



13



14



15



16



Copper Head Grade (%)



3.0



45



Tonnes (m)



NPV (m)



700
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Best Case Sequence



Best Sequence



Tonnes (m)



40



Waste



35



Ore



30



Cus



2.5 2.0



25



1.5



20



1.0



15 10



0.5



5 0



Copper Head Grade (%)



3.0



45



0.0 1



2



3



4



5



6



7



8 9 Year



10



11



12



13



14



15



16



Milawa NPV Sequence Milawa NPV Sequence 3.0



45



Tonnes (m)



2.5



Ore



35



Cus



30



2.0



25



1.5



20



1.0



15 10



0.5



5 0



0.0 1



2



3



4



5



6



7



8 9 Year



10
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13



14



15



16



Copper Head Grade (%)



Waste



40
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Milawa Balanced Sequence



Milawa Balanced Sequence



Tonnes (m)



40



Waste



35



Ore



30



Cus



2.5 2.0



25



1.5



20



1.0



15 10



0.5



5 0



0.0 1



2



3



4



5



6



7



8 9 Year



10



11



12



13



14



15



16



Case Study 2 - Milawa NPV Sequence



Tonnes (m)



Milawa NPV Sequence 50 45 40 35 30 25 20 15 10 5 0



Waste Ore



1



2



3



4



5



6



7 Year
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8



9



10



11



12



Copper Head Grade (%)



3.0



45
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Case Study 2 - Milawa Balanced Sequence



Milawa Balanced Sequence



Tonnes (m)



90 80



Waste



70



Ore



60 50 40 30 20 10 0 1



2



3



4



5



6



7



8



9



10



11



12



Year



Conclusions



The mining sequence can have a profound impact on the project NPV Good solutions can require an iterative process as you refine the sequence Milawa NPV produces good NPV but may suffer from poor equipment utilisation Milawa Throughput may sacrifice NPV or require adjusted mining tonnage targets to achieve a good result
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Milawa



There are 3 basic types of specified schedule –



1. Fixed lead (generally fastest process time) 2. Milawa NPV 3. Milawa Balanced



Fixed Lead Schedule With the fixed lead option, you specify a number of benches by which the mining of each cutback is to lead the next one. If, for example, you choose a lead of 4, mining would commence on the first cutback and proceed until four benches were mined. Mining would then commence on the second cutback and would also continue on the first cutback. Work commences on the third cutback when the fourth bench of the second cutback has been completed, etc.



If you simply wish to mine the first pit top down and then mine the second pit top down, etc this is achieved using a lead of 0 (and hence each pit is mined as a worst case until the next cutback is reached)



Milawa Milawa is a linear algorithm that utilises three routines. The first routine takes a set of variables and generates a feasible schedule from them. The second is an evaluation routine which calculates the NPV or balance for an individual schedule. The third routine searches the domain of feasible schedules for the one which has the highest NPV or best balance. The routine also has logic built in to decide when to stop searching. The Milawa algorithm does not generate and evaluate all feasible schedules, as the number of feasible schedules in any analysis is extremely large. Rather it strategically samples the feasible domain and gradually focuses the search (without necessarily narrowing it) until it converges on its solution. Milawa NPV Use this mode to specify that you want Whittle to find a sequence that improves the NPV of the project within the mining and processing constraints. In this case, both a mining and processing limit exists and the Milawa NPV algorithm may not reach one limit (similar to the worst and best case scenarios)



Milawa Balanced Use this mode to specify that you want Whittle to find a sequence with improved throughput balance. In this mode, the Milawa algorithm seeks to maximise the usage of production facilities early in the life of the mine instead of maximising NPV. This option will only be of use if you specify at least two of the possible mining, processing or selling limits. For a quick and simple schedule, we will use the Fixed Lead algorithm with a lead of 0 to produce a schedule for pits 4 and 8.
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1. Copy the Pit 8 Best schedule graph and bench schedule nodes and rename the copy Pit 4 and 8 fixed (no lead). 2. Fill out the Schedule tab as shown below. Ensure the first pit (pit 4) has been added under the Specified Case Pushback Definitions section.



To save time we’ll also test which pit produces more desirable results as a starter pit. 3. Before running the new nodes, copy them again to produce a series of fixed lead schedule graphs and bench schedules using pits 3 & 8, 5 & 8 and 6 & 8 similar to that shown below. 4. When all of the nodes have been added, run all nodes.
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The graphs show that as the starter pit number increases the waste is mined later in the total mine life. Compare the NPV’s of the various scenarios. Pits 4 & 8 have the same NPV of $43.3 million as Pits 5 & 8. The cashflows are the same however the total tonnage mined each year is very different.



Despite the very similar cashflows, the pit 4 and 8 option is much more attractive in terms of mining capacity. All of the schedules so far have fully utilised the mill while there is spare mining capacity in many years.



We’ll now use Milawa to generate the highest NPV schedule for pits 4 and 8.
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5. Copy a schedule graph/bench schedule branch and call it Pits 4 and 8, Milawa NPV. 6. Complete the form as shown below and run the branch.
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7. Compare the bench schedule and the graphs of the fixed lead and NPV schedules for pits 4 and 8. For this project, the top down mining of pits 4 and 8 is the highest NPV option.



8. Now create a Milawa Balanced schedule for pits 4 and 8 and compare the NPV and the timing of mining pit 8.



The Balanced option tries to fill both mining and milling capacity each year. As there is a large mining capacity, the mining limit has not been reached in any year but all of the waste mining has been brought forward.



The bench schedule shows that pit 8 (pushback 2) is mined in every year in an attempt to reach the mining limit.
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Finally we’ll investigate the affect of adding a lead to a fixed lead schedule. 9. Copy the pit 4 and 8 fixed (no lead) branch and change the lead to 4 as shown below:
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With no lead, pit 4 is completely finished before the waste stripping of pit 8 occurs. With a lead of 4 benches the waste of pit 8 is brought forward into year 1 and the bottom of pit 4 is pushed back from year 2 to year 3. This change in schedule reduces the project NPV by $0.5 million.
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We’ve explored the basic scheduling options using the chosen pits of 4 and 8. Next we’ll look at changing the mining capacity to achieve a more realistic result. In this case, we’ll assume the mill capacity is fixed since the mill is already built and the company does not want to spend any money at the start of the mine life. The following process could just as easily be used to test the financial impact of increasing the milling capacity.



10. Highlight the Operational Scenario node ($ symbol) and make a copy of the branch. 11. Rename the new Operational Scenario to 5 Mtpa mining, 800ktpa processing as shown below:



12. Change the mining limit in the Limits tab to 5,000,000. 13. Leave all of the graphs and schedules beneath the node and run all nodes.
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Investigate the changes caused by limiting mining to 5 Mtpa. Firstly comparing all of the fixed schedules with no lead, the pit 4 and 8 combination still gives the highest NPV. The 5 Mtpa scenario makes about $150 k LESS than the 9 Mtpa scenario. The output of the 4 and 8 fixed schedule shows that the mill is not quite filled in year 2 due to the mining limit being reached. Whittle will mine within a period until any one of the limits has been reached and then moves to the next period.



As an interesting aside, do you know how much it costs for your mill to sit idle? An actual Australian hard rock mine had a loss in revenue recently of $6000/hour! With this in mind, leaving a mill idle is not the preferred option and many operations are processing limited.



The fixed schedule with no lead is no longer the highest NPV scenario with the NPV scenario giving $80k more cashflow. The graphs look very similar as shown below.
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The bench schedule for the NPV scenario shows that a small amount of waste from pit 8 is mined in year 1 which exposes more ore to be mined in year 2 as shown below:



In the 5 Mtpa scenario, the Balanced option gives an NPV very close to the NPV option ( 
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